Software Updates
Occasionally updates and enhancements to the NEC Display Wall Calibrator software will be made available. Visit the NEC Display Wall Calibrator section of the NEC DISPLAY SOLUTIONS web site to check for availability, or use the Check for updates feature in the software to automatically see if a newer version is available.

NEC DISPLAY SOLUTIONS welcomes feedback and suggestions for product improvements. Please use the feedback from on the NEC Display Wall Calibrator section of the NEC DISPLAY SOLUTIONS web site.

Technical Support and Feedback
For technical support with the NEC Display Wall Calibrator product, please visit the NEC Display Wall Calibrator section of the NEC DISPLAY SOLUTIONS web site and check for any Frequently Asked Questions that may help to solve the issue. An online feedback form is available for submitting questions and feedback.

Trademarks and Copyright
Microsoft and Windows are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.

Apple, Macintosh, Mac and the Mac logo are trademarks of Apple Computer, Inc., registered in the U.S. and other countries.

Copyright © 2009-12 NEC Display Solutions, Ltd.
The content of this manual is furnished for informational use only, is subject to change without notice, and should not be construed as a commitment by NEC Display Solutions, Ltd. NEC Display Solutions, Ltd. assumes no responsibility or liability for any errors or inaccuracies that may appear in this manual.

All rights reserved. Your rights of ownership are subject to the limitations and restrictions imposed by the copyright laws as outlined below.

It is against the law to copy, reproduce or transmit, including without limitation electronic transmission over any network, any part of the manual except as permitted by the Copyright Act of the United States, Title 17, United States Code. Under the law, copying includes translation into another language or format.

The above is not an inclusive statement of the restrictions imposed on you under the Copyright Act.

For a complete statement of the restrictions imposed on you under the copyright laws of the United States of America, see Title 17, United States Code.

USA and Canada: www.necdisplay.com
Europe: www.nec-display-solutions.com
Asia Pacific: www.nec-display.com/ap/contact/

Revision 120328
HARDWARE LIMITED WARRANTY (U.S.A. and Canada Only)

NEC DISPLAY SOLUTIONS warrants the NEC Display Wall Calibrator “Calibration Sensor” Hardware (hereinafter “Product” or “Products”) to be free from defects in material and workmanship and, subject to the conditions set forth below, agrees to repair or replace (at NEC DISPLAY SOLUTIONS’s sole option) any part of the enclosed unit which proves defective for a period of one (1) year from the date of first consumer purchase. Spare parts are warranted for ninety (90) days. Replacement parts or unit may be new or refurbished and will meet specifications of the original parts or unit.

This warranty gives you specific legal rights and you may also have other rights, which vary from state to state. This warranty is limited to the original purchaser of the Product and is not transferable. This warranty covers only NEC DISPLAY SOLUTIONS-supplied components. Service required as a result of third party components is not covered under this warranty. Service required as a result of abuse or improper usage is also not covered under this warranty. In order to be covered under this warranty, the Product must have been purchased in the U.S.A. or Canada by the original purchaser. This warranty only covers Product distribution in the U.S.A. or Canada by NEC DISPLAY SOLUTIONS. No warranty service is provided outside of the U.S.A. or Canada. Proof of Purchase will be required by NEC DISPLAY SOLUTIONS to substantiate date of purchase. Such proof of purchase must be an original bill of sale or receipt containing name and address of seller, purchaser, and the serial number of the product.

NEC DISPLAY SOLUTIONS SHALL NOT BE LIABLE FOR DIRECT, INDIRECT, INCIDENTAL, CONSEQUENTIAL, OR OTHER TYPES OF DAMAGES RESULTING FROM THE USE OF ANY NEC DISPLAY SOLUTIONS PRODUCT OTHER THAN THE LIABILITY STATED ABOVE. THESE WARRANTIES ARE IN LIEU OF ALL OTHER WARRANTIES EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. SOME STATES DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES OR THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES SO THE ABOVE EXCLUSIONS OR LIMITATIONS MAY NOT APPLY TO YOU.

This Product is warranted in accordance with the terms of this limited warranty. Consumers are cautioned that Product performance is affected by system configuration, software, the application, customer data, and operator control of the system, among other factors. While NEC DISPLAY SOLUTIONS Products are considered to be compatible with many systems, specific functional implementation by the customers of the Product may vary. Therefore, suitability of a Product for a specific purpose or application must be determined by consumer and is not warranted by NEC DISPLAY SOLUTIONS.

Federal Communications Commission (FCC) Notice (U.S.A. Only)

WARNING: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

This device complies with Part 15 of the FCC rules. Operation is subject to the following two conditions:

- This device may not cause harmful interference.
- This device must accept any interference received including interference that may cause undesired operation.
## Contents

Precautions: ............................................. 6  
Note: .................................................... 6  
Supported Display Monitors: ......................... 7  
System Requirements: ................................. 8  

1 Introduction to NEC Display Wall Calibrator ................. 9  
   Overview ............................................ 9  
   Main Features and benefits ......................... 10  
   Introduction to display monitor calibration .......... 11  
   About Calibration Targets .......................... 11  

2 Calibration Overview ..................................... 11  
   Intensity ............................................ 12  
   White Point ......................................... 13  
   Gamma and Tone Response Curves (TRC) .............. 13  
   Contrast Ratio ..................................... 14  
   Calibration Steps ................................... 14  
   Calibration Projects ................................. 15  
   Analog Video Inputs - Important Notice ............. 15  

3 Planning and Configuring a Wall Layout ....................... 16  
   Planning ............................................. 16  
   Configuring Connections ............................. 16  
   Daisy-chained RS232 with one COM port ............... 17  
   Single IP LAN with daisy-chained RS232 ............... 19  
   Multi IP LAN ........................................ 20  
   Wireless multi IP LAN with daisy-chained RS232 ...... 21  
   Configuring a Layout with the Layout Wizard ........ 22  
   Calibration Times .................................... 26  
   Video Inputs ........................................ 26  

4 Dialogs, Settings and Menus .................................. 27  
   Main NEC Display Wall Calibrator window .......... 27  
   Edit Calibration Target Configuration dialog ......... 29  
   Custom Gamma Curve dialog ......................... 31  
   Custom White Point dialog ......................... 32  
   Preferences dialog .................................... 33  
      Preferences dialog - Calibration Sensor tab ...... 33  
      Preferences dialog - Calibration tab .............. 34  
      Preferences dialog - Advanced tab ................. 35  
      Preferences dialog - Interface tab ................. 36  
   Panels .............................................. 37  
      Actions panel ..................................... 37  
      Connection panel ................................ 39  
      Calibration Target panel ......................... 39  
      Colorimeter panel ................................ 40  
      Test Pattern panel ................................ 41  
      Reset panel ....................................... 42  
      Display Measurements panel ....................... 43  
      Tile Matrix Wizard dialog ......................... 44
<table>
<thead>
<tr>
<th></th>
<th>5 Quick Start to NEC Display Wall Calibrator</th>
<th>59</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>6 Frequently Asked Questions</td>
<td>61</td>
</tr>
<tr>
<td></td>
<td>Calibration</td>
<td>61</td>
</tr>
<tr>
<td>7</td>
<td>7 Troubleshooting</td>
<td>63</td>
</tr>
<tr>
<td></td>
<td>Installation and Setup</td>
<td>63</td>
</tr>
<tr>
<td></td>
<td>Calibration</td>
<td>64</td>
</tr>
<tr>
<td></td>
<td>Color Sensor</td>
<td>65</td>
</tr>
<tr>
<td>8</td>
<td>8 Assigning an IP address</td>
<td>66</td>
</tr>
<tr>
<td>9</td>
<td>9 Calibration Determination Flowchart</td>
<td>68</td>
</tr>
<tr>
<td>10</td>
<td>10 Visual Trim function</td>
<td>69</td>
</tr>
<tr>
<td>11</td>
<td>11 Advanced Analog Adjustment function</td>
<td>71</td>
</tr>
<tr>
<td>12</td>
<td>12 Calibration Method Comparison</td>
<td>75</td>
</tr>
<tr>
<td></td>
<td>Glossary</td>
<td>77</td>
</tr>
</tbody>
</table>
Precautions:

- The LCD display monitor screen is fragile and can be easily damaged if force is applied. Even slight forces applied to the screen can cause temporary color distortions that can impact the calibration process.

- Never use suction cups to attach a color sensor to the display.

- Always use the supplied cable or sling and counterweight to gently rest the color sensor on the face of the display, or hold gently and steadily against the screen surface by hand, using the minimum possible force.

- Always try and position the color sensor in the center of the screen when taking measurements or calibrating.

- During the display calibration procedure, highly sensitive light measurements are made on the screen using the color sensor. High ambient light levels such as direct sunlight on the screen, may affect measurements and cause an inaccurate display calibration. Changes in ambient lighting can alter how images on the screen are perceived.

- Always store the color sensor in the holder when not in use.

- When using the X-Rite Eye-One Display, the white plastic diffuser must be removed prior to taking any measurements. Replace it when finished to protect the sensor from dust and damage.

- Never touch the measurement window in the color sensor.

- Never disconnect the color sensor while the NEC Display Wall Calibrator software is running.

- Always allow the displays to warm up for at least 30 minutes before calibrating.

Note:

- **USB extender cables** - Some models of color sensors may not work properly when using a USB extender cable or when connected via a USB hub device. If you experience problems with detecting color sensor or taking measurements with the color sensor, try connecting it directly to the host PC.

- This document covers both the Mac OS and Windows versions of the software. The features and functions of both versions are identical unless noted otherwise. The majority of the User Interface screen images in this document show the Windows version, however the Mac OS version is identical unless noted otherwise.

- **Analog Video Inputs** - When using analog video inputs on the displays it may be necessary to automatically adjust the video signal levels to compensate for variations in the video signals that may cause color shifts between displays. See the Analog Inputs - Important Notice for more information.
Supported Display Monitors

NEC Display Wall Calibrator supports the following NEC display monitor models:

- X431BT – 43” LCD monitor
- X461S – 46” LCD monitor
- X461UN – 46” LCD monitor
- X462UN – 46” LCD monitor
- X463UN – 46” LCD monitor
- X461HB – 46” LCD monitor
- X462HB – 46” LCD monitor
- X551S – 55” LCD monitor
- X551UN – 55” LCD monitor
- P401 – 40” LCD monitor
- P402 – 40” LCD monitor
- P461 – 46” LCD monitor
- P462 – 46” LCD monitor
- P521 – 52” LCD monitor
- P551 – 55” LCD monitor
- P552 – 55” LCD monitor
- P701 – 70” LCD monitor
- P702 – 70” LCD monitor
- S401 – 40” LCD monitor
- S461 – 46” LCD monitor
- S521 – 52” LCD monitor
- M401 – 40” LCD monitor
- M461 – 46” LCD monitor
- M521 – 52” LCD monitor
- V422 – 42” LCD monitor
- V462 – 46” LCD monitor
- V551 – 55” LCD monitor
- V651 – 65” LCD monitor
- LCD4020 – 40” LCD monitor *
- LCD4620 – 46” LCD monitor *
- LCD5220 – 52” LCD monitor *
- LCD6520 – 65” LCD monitor *
- M40, M40B, and M40-2 – 40” LCD monitors *
- M46, M46B, and M46-2 – 46” LCD monitors *

Newer models not listed may also be supported.

* These models do not have LAN interfaces and only RS232 is supported for control and calibration.
## System Requirements

*NEC Display Wall Calibrator* has the following system requirements:

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Microsoft Windows</th>
<th>Mac OS</th>
<th>Mac OS 10.5 and higher.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported Color Sensors</td>
<td>• GretagMacbeth Eye-One Display V1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• X-Rite/GretagMacbeth Eye-One Display V2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• X-Rite/GretagMacbeth Eye-One Monitor, Eye-One Pro</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• X-Rite ColorMunki</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• X-Rite iOneDisplay Pro</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• NEC SpectraSensor Pro</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• NEC MDSVSensor</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Monaco OptixXR (X-Rite DTP 94)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• X-Rite Hubble (Windows only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ColorVision/Datacolor Spyder 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Datacolor Spyder 3</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Datacolor Spyder 4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>USB</td>
<td>At least one available USB port for Color Sensor.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>An active USB extender cable of up to 5M (16 feet) in length can be used if necessary with some models of color sensors. USB extender cables should not be used with the X-Rite/GretagMacbeth Eye-One Monitor, Eye-One Pro or X-Rite ColorMunki sensors.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LAN (for supported display models)</td>
<td>Standard TCP/IP LAN interface (optional if using RS232 or Wireless LAN)</td>
<td>Included on all Macs</td>
<td></td>
</tr>
<tr>
<td>RS232</td>
<td>One or more RS232 COM Ports (optional if using LAN).</td>
<td>A USB to RS232 adapter can be used if connecting the Mac to displays via RS232 instead of via LAN.</td>
<td>Null modem cables to connect devices.</td>
</tr>
</tbody>
</table>
Introduction to NEC Display Wall Calibrator

Overview

The aim of the NEC Display Wall Calibrator system is to automatically adjust multiple displays used in a video wall so that the color characteristics closely match, thereby creating the visual illusion of a single large display.

In order to accomplish this, the color characteristics of each display must be individually measured and compared to all of the other displays in the video wall. The optimal settings for each display can then be calculated so that all the displays will match after calibration.

Since each display will vary in both color and intensity (brightness), due to aging, individual components and tolerances, it is necessary to find the lowest common denominator that all of the displays are capable of collectively achieving. In other words, the video wall can only be as bright as the dimmest individual display.

The color characteristics of each display are measured using a color sensor, which is connected via USB to a host PC. The sensor is placed on the screen and a series of test patterns is generated and measured. This process is repeated for all displays.

The host PC does not have to supply any type of video signal to the displays in the video wall, as test patterns are automatically generated within in each display. Communications with each display from the host PC are performed via either RS232, or LAN (Ethernet) if supported by the display model.

Once all of the displays have been measured, the calibration Target can be calculated. This Target defines the various calibration parameters such as the white point (color of pure white on the screen), intensity (brightness), gamma, etc.

Each display is then calibrated to this Target setting by placing the color sensor on the screen while the software adjusts the internal controls of the display. This process is repeated for all displays.

When the calibration process is completed, all of the displays will match. The numerical results of the calibration process can be viewed, and also the configuration settings for each display and the entire project can be saved for future reference and use.

Once the connections to each display have been made and configured, the measurement and calibration process typically takes between 3 to 6 minutes per display.

The time until the displays need to be re-calibrated will depend on many factors such as the environment and duration they are used, the age of the displays, the calibration Target settings used, and how critical the color matching requirements are. Newer displays will tend to drift more rapidly than displays that have been in use for several days or weeks.
Main Features and benefits

*NEC Display Wall Calibrator* provides the following features and benefits:

- **Automatic calibration** - *NEC Display Wall Calibrator* communicates with the display monitors directly using either RS232 or a LAN (Ethernet) connection (on supported models). All adjustments to the display settings are performed automatically using this communications link. It is not necessary to manually configure the displays as all of the necessary settings are made by the software.

- **Internal Test Patterns** - Displays can be calibrated using internally generated test patterns. This simplifies the operation by allowing calibration to be performed automatically without having to manually select different test patterns during the calibration process, and without the need to connect a PC to the video input of the displays.

- **10 bit internal Look Up Tables (LUTs)** - Each LCD display monitor supported by *NEC Display Wall Calibrator* features three internal 10 bit LUTs. These tables allow very precise adjustments to be made to the display’s Tone Response Curve without reducing the number of displayable colors or introducing color banding artifacts.

- **Gamma Correction** - As well as adjusting the Intensity (luminance) and white point of the displays, the software can also calibrate the grayscale using the internal LUTs of the displays. This means that highly accurate color can be achieved not only at 100% white, but at all steps along the grayscale. A variety of different Tone Response Curves can be applied also, from something as simple as a small simple gamma value to complex custom curves.

- **Flexible Connections** - Displays can be connected using RS232, LAN, or in combinations of both, to the host PC used to perform the calibration. By using a wireless equipped host PC and LAN, displays can be calibrated without making any physical connections to the host PC.

- **Projects** - All display configurations, measurements, and calibration data can be saved as a project file for later reference, re-calibration etc.

- **Multiple Calibration Sets** - Different display monitor calibration projects can be uploaded to each group of displays allowing quick and easy switching between different calibration settings without the need to re-calibrate each display.

- **Informative** - A Summary window shows the results of the calibration and the measurement data. This allows for detailed logging and reporting of the calibration procedure.

- **Flexible** - *NEC Display Wall Calibrator* provides many features and options that make it flexible enough to be used in a large variety of video applications, including “on set” use in TV studios and full DICOM support for medical imaging.

- **Colorimeter function** - The software features a Colorimeter function which allows direct measurements to be taken by the color sensor and the results displayed in a variety of different formats.

- **Scalable** - Video wall sizes from a 1x1 single display, to a 10x10 are supported.
Calibration Overview

Introduction to display monitor calibration

The screen image on color LCD displays is created by emitting white light from a backlight source such as cold cathode fluorescent lamps (CCFLs) or Light Emitting Diodes (LEDs) and then passing it through individual sub-pixels with red, green and blue filters which form each pixel on the screen. The amount of light that is allowed to pass through each pixel is controlled to form an image on the screen. The color of each pixel is controlled by varying the ratios of light passing through each of the red, green and blue sub-pixels.

The overall brightness or Intensity of the screen is controlled by adjusting the brightness of the fluorescent lamp backlight, however the adjustment range of the backlight is limited. If it is necessary to adjust the Intensity below the level achieved by adjusting the fluorescent lamp backlight alone, further adjustments can be made using the internal LUTs (look up tables) in the display which control the light that passes through each individual pixel.

Likewise, White Point adjustments to the display are made using the internal LUTs to reduce the brightness of one or more colors (red, green, or blue).

Before calibrating, the desired color characteristics of the calibrated video wall must be selected. In NEC Display Wall Calibrator these characteristics are called Calibration Targets. The software adjusts the monitors to the color characteristics in the selected Target.

When calibrating a video wall, careful consideration should be made as to how the displays will be calibrated so that they match as necessary. The video content shown on the displays, and how it will be divided on individual displays will determine some of the calibration settings.

For example, when using a video wall consisting of several displays that will be displaying video tiled across all of the displays simultaneously, it is essential that all of the displays match in both White Point and Intensity (brightness).

However, if for example, the displays each show separate video on their screen, then the Intensity matching between the displays may not be as important as having each display be as bright as possible. Having the displays match in White Point only may be sufficient.

The NEC Display Wall Calibrator system provides the flexibility for meeting different scenarios such as these.

When calibrating a video wall to match in both White Point (color) and Intensity (brightness), the Target Intensity can only be as high as the dimmest display. This is why it is necessary to first measure all of the displays in their native or uncorrected state to find out the native White Point and Intensity values for each display. From these measurements, the lowest common Intensity value for the chosen White Point can be calculated by the software.

About Calibration Targets

A Calibration Target consists of up to four specifications that describe the color characteristics of the display:

- Intensity
- White Point
- Gamma or Tone Response Curve (TRC)
- Contrast Ratio
Intensity

Intensity specifies the luminance or “brightness” of white when displayed on the screen. The maximum Intensity value of a display will depend on many factors, such as, the color temperature of the White Point selected, the type of monitor, individual component tolerances, usage, and age of the display.

Intensity can be measured and specified in units of either Candelas (cd/m²) or Foot Lamberts (fl) within the application.

The NEC Display Wall Calibrator system supports 3 different methods of Intensity adjustment:

- **Maximum Possible Matching** - Calibrates all of the displays to the maximum possible luminance that can achieve a match in both Intensity and White Point. Use this option if it is desired that all of the displays match in both color and brightness. All of the displays will only be as bright as the dimmest display.

- **Maximum Possible Per Display** - Calibrates all of the displays to the maximum possible luminance that each individual display can achieve, while matching up the white points on each display. Use this option if it is desired that all of the displays match in color, but is not important if they match each other in luminance.

- **Specific Level** - Calibrates all of the displays to a specified target value of luminance, while matching the white points on all displays. If a display can not achieve the specified value, it will be calibrated to the closest possible Intensity, and a warning icon will be displayed after the calibration process is completed. Use this option if the particular application requires a specific luminance, but keep in mind that each display must actually be capable of achieving that value.

The difference between Maximum Possible Matching and Maximum Possible Per Display Intensity adjustment types is illustrated below:

**Maximum Possible Matching Intensity Adjustment**

![Diagram](image1)

**Maximum Possible Per Display Intensity Adjustment**

![Diagram](image2)
The choice of Intensity adjustment method will depend on the particular application and viewing environment.

If the displays are being used in a bright environment, then the Intensity would generally need to be the maximum possible. So either **Maximum Possible Matching** or **Maximum Possible Per Display** would be used.

**White Point**

The White Point specifies the color of pure “white” on a display. Since there is no unique perceptual or physical definition of what “white” is, it must be defined in terms of a standard or device-independent color space to be measured and reproduced.

There are several methods of specifying a white point, including using a blackbody radiator color temperature or as a point in a device-independent color space. **NEC Display Wall Calibrator** allows the white point to be specified either as a black body radiator color temperature in Kelvin, as a CIE standard illuminant, or as CIE xy chromaticity coordinates.

A White Point expressed as a blackbody radiator color temperature in Kelvin represents the light given off by an object, known as a blackbody, as it is heated to a given temperature. Low color temperatures, such as 2500K, are reddish, while higher color temperatures, such as 9300K, are bluish. A color temperature of 6500K is considered to be “neutral” white.

A CIE Standard Illuminant is a defined white color based on a known light source. In **NEC Display Wall Calibrator** the D or Daylight Illuminant series can be used to specify a white point. Daylight Illuminants are named according to their corresponding correlated color temperature. For example, D50 is very close in color to a 5000K blackbody radiator.

Since adjusting the White Point away from the native value of the display involves reducing the level of at least one color (red, green, or blue), the brightest possible display will be when least amount of correction is made. Choosing a White Point that is very different from the native White Point will mean that a large correction must be applied, and the maximum brightness will be impacted.

If the application the video wall is being used for does not need a specific White Point, and the brightest possible display is required, a White Point that will achieve the highest possible overall Intensity after calibrating can be automatically calculated. This calculation factors in the native Intensity and White Points of each display in order to determine the resulting White Point. This function is available in the White Point group in the **Edit Calibration Target** dialog.

**Gamma and Tone Response Curves (TRC)**

The Gamma or Tone Response Curve of a display is the relationship between the video input signal level and the light output (“brightness”) displayed on the monitor. The display monitor is a nonlinear display device. In simple terms, this means that doubling the level of the video input signal to the display does not double the light output. For CRT based displays, the light output follows a mathematical power function of the input video signal. This power function has an exponent called gamma, which is commonly used to describe the relationship between the video input signal and light output of the screen.

A gamma value of 1 would result in a perfectly linear display (doubling the signal level doubles the light output) and the Tone Response Curves would be straight lines. The particular Tone Response Curves of a display will change with the display color settings and may vary from one display to the next. If accurate color matching is to be performed, the display’s Tone Response Curves must be accurately measured and compensated for. **NEC Display Wall Calibrator** uses the color sensor to automatically measure the Tone Response Curves of the display.

Normally, a standard Gamma value is required when working with images. For example, the sRGB standard color space target specifies a display Gamma value of 2.2. Since the Gamma value of the display may be different than the required Gamma value, a correction needs to be applied so that the apparent display Gamma matches that of the required Target. In **NEC Display Wall Calibrator**, this correction is applied to the LUTs (Look Up Tables) inside the monitor. The software also uses the monitor’s LUTs for Targets that have Tone Response Curves which do not follow a normal Gamma curve. An example is DICOM, which uses a curve that changes shape based on how bright the display is.
Calibrating the gamma or Tone Response Curve of the display during calibration will automatically correct for any color deviations in shades of gray between black and white. This provides the best possible grayscale color tracking.

**Contrast Ratio**

The Contrast Ratio of the display is the ratio of the measured Intensity to the measured Black Level. The Black Level is the luminance or “brightness” of black when displayed on the screen. For LCD monitors the minimum or **native** Black Level is typically fixed in ratio to the Intensity value due to the display technology.

**NEC Display Wall Calibrator** allows the Contrast Ratio to be selected for applications that require a specific contrast ratio. However the calibrated contrast ratio can not be higher than the native contrast ratio, since the minimum Black Level that the display can achieve is limited by the display technology.

The Contrast Ratio is adjusted (reduced) by increasing the black level as necessary.

For most applications the highest possible Contrast Ratio is most suitable and can be achieved by selecting **Monitor Default** as the **Contrast Ratio**.

Specific Contrast Ratios in the range 50:1 to 500:1 can be selected.

**Note:** If the selected contrast ratio is higher than what the display is actually capable of achieving, then the display will calibrate to the highest possible contrast ratio. For example if 500:1 is selected, but the display is only capable of say 320:1 with the current Target settings, then the resulting calibration will have a contrast ratio of 320:1.

**Calibration Steps**

The display calibration process for a video wall when matching both the Intensity and White Point is outlined in the following steps:

1. **Initializing Displays** - This step resets each display to the default color settings so that the “native” performance of each display can be measured before the calibration. Settings such as the Brightness, Color mode, Contrast etc. will be reset.

2. **Measuring Displays** - During this step, all displays are measured to determine the default “native” color characteristics of each display. This step involves placing the color sensor on the screen while various test patterns are displayed and measured. This step repeated for all displays in the video wall.

3. **Target Calculation** - Once all of the displays have been measured the software will automatically calculate the maximum possible Intensity that will give a color match with all the displays. This is done by determining the dimmest display in the video wall at the chosen White Point.

4. **Calibrating Displays** - Once the Target has been calculated, all of the displays can be calibrated. This step involves placing the color sensor on the screen while various test patterns are displayed and the display is adjusted. This step repeated for all displays in the video wall.

5. **Visual Trim (fine tune by eye)** - If necessary, the white point and brightness of any of the displays can be fine tuned visually by using the software.

**Note:** When calibrating to a Target that uses either Maximum Possible Per Display or Specific Level option for the Intensity, steps 1 and 2 are optional because it is not necessary to measure and calculate the matching Target value.

However if Specific Level is used, performing steps 1 and 2 will allow the software to verify that each display is capable of achieving the specified Intensity value at the selected White Point. If a display can not achieve this, then a yellow warning icon is shown in both the Summary window, and in the main display window for that particular display.
Calibration Projects

The NEC Display Wall Calibrator application uses Project files to store the following information and settings:

- Layouts including all of the connection settings and video wall size information.
- Measurements for each display, including the time each measurement was taken.
- Calibration results for each display, including the final color characteristics of each display and when it was calibrated.
- Calibrated Monitor Settings for each display so that settings can be restored to one or all displays if necessary.

All of the display measurements and settings are unique to each display and are identified within the software by the model and serial number of each display.

Project files can be saved at any point. By saving Projects using different file names, different configurations for the same video wall can be stored and later restored to the displays if necessary.

Project files can also be used to keep track of when a video wall was last calibrated.

Analog Video Inputs - Important Notice

The display calibration process adjusts the digital portion of the video processing within the display. For analog video signals such as VGA, RGB/HV, and Option-Analog, the signal is digitized within the display using an Analog-to-Digital converter. Due to variances in analog video signal levels and offsets from the video source device, it may be necessary to also adjust the settings for the video Analog-to-Digital conversion.

If the screens on the video wall do not match well in color after calibration, use the Test Pattern tool with the Calibrated White setting to evaluate the displays using their internally generated test patterns. If the Test Patterns match well, then it indicates that the analog video signal levels need to be adjusted. Use the Display Settings dialog - Video tab to perform an automatic adjustment of the video levels.

If the analog automatic adjustment procedure still does not provide a good enough match between displays, a more advanced manual method of adjusting the analog video signal levels can be used.

See the Calibration Determination Flowchart for a more detailed guide on the process of determining when to calibrate and perform the analog setup.

Note: This adjustment process requires specific patterns to be displayed on the video signal in order for the display to automatically adjust the video signal levels correctly. Failure to display the correct signal may result in the video levels being incorrectly set and the displays may not match in color when using an analog video source.
3 Planning and Configuring a Wall Layout

Planning

In order for the software to uniquely identify and communicate with each display, the software must be correctly configured with the following settings:

- The number of rows and columns of displays in the video wall.
- The communications interface type for each display (RS232 or LAN).
- The connection RS232 COM Port or IP address of each display.
- The MONITOR ID of each display.
- The order in which displays should be measured and calibrated.

For large video walls where it is necessary to use a ladder or platform to access the screen of each display, careful consideration should be made of the layout order in order to minimize physical movement and in turn maximize the efficiency and speed of the calibration process.

For example, if using a ladder, it may be easier to calibrate a vertical column of displays, and then move the ladder across to the next column. Similarly if using a horizontal platform, it may be easier to calibrate a horizontal row of displays, and then move the platform up or down to the next row.

For very large video walls, for example larger than a 5x5, it may be more efficient to split the calibration into two separate projects and divide the wall into two. However keep in mind that depending on the calibration Target type being used, it may be necessary to measure all of the displays in the video wall in order to determine the dimmest display.

The physical wiring connection order between displays does not dictate the order in which the displays are measured and calibrated, since MONITOR IDs and IP addresses can be configured for each display.

Configuring Connections

Displays can be connected to the host PC via either RS232 or LAN (if supported by the display model), in several different configurations. A wireless LAN connection can also be used from the host PC if using a wireless access point or router.

Keep in mind the following points when configuring and connecting displays:

- If using RS232 to connect displays using a daisy-chain, each display on the chain must have a unique Monitor ID (set on the display’s OSD).
- If using RS232, displays should be connected using an RS232 serial NULL modem cable.
- The RS232 connection from the host PC should connect to the RS232 IN on the first display.
- The RS232 OUT of a display should connect to the RS232 IN on the next display in the daisy-chain.
- If using LAN to connect to one or more displays, make sure that the IP address of each display is set correctly and that each display has a unique IP address (set using a web browser). Also make sure that the displays are on the same subnet as the host PC being used.

Examples of various connection configurations are shown on the following pages.
Daisy-chained RS232 with one COM port

In this example, the host PC has one RS232 COM port, and all displays are daisy-chained together. Each display must have a unique MONITOR ID since they are all on the same daisy-chain. The RS232 OUT on the first display is connected to the RS232 IN on the next, etc.

Note: The cable connections between displays does not need to follow the same ordering as the ID assignments. In this example the daisy-chain is connected in order 1 - 2 - 4 - 3.

The following image shows how this layout looks in the Summary window when configured. Notice that all displays are configured to use the same COM port, even though only the first display is actually connected to the host PC.
Daisy-chained RS232 with multiple COM ports

In this example, the host PC has two RS232 COM ports, and there are two separate daisy-chains. Each display on a daisy-chain must have a unique MONITOR ID.

The following image shows how this layout looks in the Summary window when configured. Notice that displays connected on COM1 can have the same IDs as those on COM2 because they are on separate daisy-chains.
Single IP LAN with daisy-chained RS232

In this example, the host PC is connected to the first display via LAN. Subsequent displays are connected together using RS232 daisy-chaining. Each display on a daisy-chain must have a unique MONITOR ID.

The first display is configured to use LAN as the EXTERNAL CONTROL on the OSD. The other displays are configured to use RS232 as the EXTERNAL CONTROL on the OSD. The RS232 OUT on the first display is connected to the RS232 IN on the next display.

Since communications to all of the displays is routed through the first display, the software is configured to use the IP address of the first display for each display. The first display will translate commands via LAN to the RS232 OUT to be received by the other displays in the video wall.

*Note:* The first display must be a model that has a LAN interface. Display models that do not have a LAN interface can only be used when connected to the first display by RS232.

The following image shows how this layout looks in the Summary window when configured. Notice that all of the displays are configured in the software to use the LAN IP address 192.168.0.1, even though displays 2, 3, and 4 are connected together via RS232.
Multi IP LAN

In this example, the host PC and each display is connected via a LAN HUB. Each display has a unique IP address and is configured to use LAN as the EXTERNAL CONTROL on the OSD.

The software is configured with the IP address and MONITOR ID of each display.

The ID of each display does not need to be unique since the displays are not daisy-chained, however the ID set on the OSD must match that set in the software.

Note: This configuration is not available with display models that do not have a LAN interface.

The following image shows how this layout looks in the Summary window when configured.
Wireless multi IP LAN with daisy-chained RS232

In this example, the host PC is connected to a LAN via a wireless connection. Display 1 and Display 3 are connected to the LAN, have unique IP addresses, and are configured to use the LAN on the EXTERNAL CONTROL setting on the OSD.

Other displays are daisy-chained from the two displays connected to the LAN. Each display on a daisy-chain has a unique ID assigned, and is configured to use RS232 on the EXTERNAL CONTROL setting on the OSD.

Since communications to Display 2 is routed through Display 1, the software is configured to so that Display 2 uses the IP address of Display 1, even though Display 2 is configured to use RS232 on the OSD. Likewise the software is configured so that Display 4 uses the IP address of Display 3.

Note: Display models that do not have a LAN interface can only be used in this configuration if connected to the first displays by RS232 (displays with ID2 in the example above). The first displays must be models that have LAN interfaces.

The following image shows how this layout looks in the Summary window when configured. Notice that Display 2 is configured in the software to use the LAN IP address 192.168.0.1 of Display 1, even though it is connected to Display 1 via RS232. Likewise Display 4 is configured in the software to use the LAN IP address 192.168.0.2 of Display 3, even though it is connected to Display 3 via RS232.
Configuring a Layout with the Layout Wizard

The Layout Wizard is accessed from the Edit menu and will guide you through the initial layout configuration for the video wall. After the wizard is completed, changes to the configuration settings for individual displays can be made if necessary using the **Connection** panel.

In the following configuration example, a 3x2 video wall that uses a LAN connection for communications to the first display, and daisy chained RS232 from that display to the remaining 5 displays.

The number of rows and columns is entered. In this example there are 3 columns and 2 rows.

**Note:** To calibrate a single display that is not part of a video wall, enter a size of 1x1.
Next the corner location of the first display in the layout will be selected. This should generally be the display with the lowest MONITOR ID, or IP address, so that sequential IDs or IP addresses can be automatically assigned to the rest of the displays. This display will also be the first one to be measured and calibrated when automatically performing these actions on all displays.

Next the order of remaining displays can be selected. Again, this selection determines how sequential IDs or IP addresses will be automatically assigned to the rest of the displays, and the order of measurement and calibration. Keep in mind that the automatically assigned IDs or IP addresses can be modified later if necessary.
Next the connection method of the displays is selected.

In this example a LAN connection from the host PC will be used. The first display has been assigned IP address 192.168.0.1. All of the remaining 5 displays in the video wall will use an RS232 daisy-chain to communicate via the LAN connection on the first display.

Next the connection method for the remaining displays must be selected. Two options are available in this case because displays connected to the LAN can either have their own IP address and be connected to the LAN, or they can be connected to the first display via daisy-chained RS232.

In this example they are daisy-chained to the first display by RS232.
Lastly the ID of the first display is entered. The remaining displays in the layout will be assigned sequential IDs. In this example, the first display has MONITOR ID 1. Clicking Finish will end the wizard and the project will be automatically configured. It is possible to see the resulting connection configuration by opening the Summary window.

In this example all 6 displays have been assigned the same IP address in the software, even though only the first is actually connected to the LAN, because all communications from the host PC will go through the LAN address of Display 1. Also note that each display has been assigned a sequential MONITOR ID. The display OSD setting for EXTERNAL CONTROL is set to RS232 for Displays 2-6, and LAN for Display 1.
Calibration Times

Once the displays have been connected and configured, and the layout has been configured and verified in the software, the time taken to calibrate the video wall will depend on the number of displays and some of the Target parameters and Preference settings.

It will typically take about 30 seconds to measure each display. Once measured, the calibration process should take about 2 minutes per display, however this can take longer if:

- The **Use LUTs** Calibration Method is used since this measures the grayscale response, and transmits the LUT correction data to each display.
- More than the default (16) number of **Grayscale Calibration steps** is selected in the **Preferences**.
- The **Extended Intensity stabilization time** option in the **Preferences** is selected.

**Note:** If the Intensity setting in the current Calibration Target is set to Maximum Possible Per Display, it is not necessary to perform the Measurement steps. This is because each display will be calibrated to the maximum possible Intensity that it can achieve, and only the white point will match with the other displays. So it is not necessary to first measure all of the displays in order to calculate which is the dimmest display.

Likewise if **Specific Level** is being used for the Intensity setting of the current Calibration Target, and the level value being used can be achieved by all of the displays at the specified white point, then the Measurement process can be skipped. For example if it is known (from a previous set of measurements) that all of the displays can achieve an Intensity of at least 400 cd/m² at a particular White Point, then if a Target Intensity level of 300 cd/m² is used, it would not be necessary to perform the Measurement step.

The following table shows some example typical calibration times for various sized video walls:

<table>
<thead>
<tr>
<th>Wall Size</th>
<th>Measurement Time (minutes)</th>
<th>Calibration Time (minutes)</th>
<th>Total Time (minutes)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2x2</td>
<td>2</td>
<td>16</td>
<td>18</td>
</tr>
<tr>
<td>4x4</td>
<td>8</td>
<td>32</td>
<td>40</td>
</tr>
<tr>
<td>5x5</td>
<td>12.5</td>
<td>50</td>
<td>62.5</td>
</tr>
<tr>
<td>6x6</td>
<td>18</td>
<td>72</td>
<td>90</td>
</tr>
</tbody>
</table>

**Note:** When measuring and calibrating the video wall, the software will automatically move to the next display once the current display has been completed. The next display will be indicated by the screen on that display flashing alternating green and red. The software will wait until the color sensor has been placed on the display screen before automatically proceeding with the measurement or calibration process.

Video Inputs

Each video input can have its own settings for various controls, such as Brightness, Gamma Selection, Picture Mode etc.

During calibration the settings for the currently selected video input are automatically configured. However if other video inputs are going to be used as well with the video wall, then the settings for those inputs will need to be correctly configured to use the calibrated settings.

After calibration, use the **Calibration** tab on the **Display Settings** dialog to apply the calibration settings to other video inputs.
4 Dialogs, Settings and Menus

Main NEC Display Wall Calibrator window

The NEC Display Wall Calibrator window shows the current settings and status of the display calibration. All of the features of NEC Display Wall Calibrator are accessed from this window and the menus.

Some of the main features of this window are shown below.

**Actions panel**
Controls the main operations of the calibration process.

**Connection panel**
Shows the communications connection settings for the currently selected display. Settings can be modified if necessary.

**Display layout diagram**
 Shows a visual representation of the video wall layout. Individual displays can be selected by clicking on a rectangle.

**Calibration Target**
Shows the current Calibration Target settings. Click Edit... to open the Calibration Target Configuration dialog box used to modify Target settings.
The main area in the window shows a visual representation of the current video wall layout. Each rectangle represents a display. The color of the rectangle shows the current status of a particular display. This coloring makes it easy to see the status even when viewing from a distance.

Within each rectangle the displays sequence number is shown. This number is used to identify each display, and the number ordering represents the order in which displays will be measured and calibrated when performing operations on multiple displays.

Individual displays can be selected by clicking on a rectangle. The currently selected display is highlighted by a rectangle.

The layout, including the number of rows and columns in the video wall, and order of the displays is configured by using the Layout Wizard.

The Visual Trim icon is shown for any displays that have a visual trim adjustment applied to the calibration.

An individual display can be excluded from the current project by disabling it. To disable a display, right click within the rectangle and select Disable. This feature can be used for example if the video wall layout is not a rectangular shape.

An individual display can also be made to flash temporarily so it can be visually identified in the video wall. This is useful to verify that a display is correctly configured and appears at the correct location in the video wall layout. To identify a display, right click within the rectangle and select Identify.

Additional information about a display is shown in a ToolTip by hovering the pointer over a rectangle.
**Edit Calibration Target Configuration dialog**

The Edit **Edit Calibration Target** dialog is accessed by clicking the **Edit...** button on the **Calibration Target** panel in the main **NEC Display Wall Calibrator** window, or by selecting **Target...** from the **Edit** menu.

The Target defines the parameters for the calibration process and determines the color characteristics for calibrating each display. Changing the Target settings after calibrating the displays will normally mean they will all need to be re-calibrated to the new settings.

**Intensity**

The **Intensity** selects the luminance or “brightness” of white for the calibration.

Options are:

- **Maximum Possible Matching** - Calibrates all of the displays to the maximum possible luminance that can achieve a match in both Intensity and White Point. Use this option if you want all of the displays to match in both color and brightness. All of the displays will only be as bright as the dimmest display.

- **Maximum Possible Per Display** - Calibrates all of the displays to the maximum possible luminance that each individual display can achieve, and matches the white points on all displays. Use this option if you want all of the displays to match in color, but are not concerned if they match each other in luminance.

- **Specific Level** - Calibrates all of the displays to a specified target value of luminance, and also matches the white points on all displays. If a display can not achieve the specified value, it will be calibrated to the closest possible Intensity, and a warning icon will be displayed after the calibration has completed. Use this option if your application requires a specific luminance, but keep in mind that each display must actually be capable of achieving that value.
White Point

White Point selects the Target white point for the calibration. Several popular industry standard White Point values, such as 9300K and D65, are provided.

A custom white point can be specified by clicking the Edit... button to open up the Custom Color Temperature dialog.

If the absolute highest possible Intensity is needed for an application and the White Point does not need to be a particular value, then the Calculate Highest Intensity White Point function can be used to calculate the White Point that gives the highest overall Intensity. This White Point value is calculated from the “native” or un-calibrated measurements taken from all of the displays so all displays should be measured before using this function. Clicking the Calculate Highest Intensity White Point button will update the current White Point with the calculated value.

Gamma Curve

Gamma Curve selects the desired tone response curve of the calibrated displays.

Options are:

- **Monitor Native Gamma** - No correction is applied and the display’s Look Up Tables are set to linear.
- **Gamma Curve Value** - The response curve will follow a simple gamma curve. Values between 1.0 and 3.0 can be entered. A gamma value of 2.2 is popular for most applications.
- **DICOM Curve** - The response curve follows the DICOM (Digital Imaging and Communications in Medicine) specification. This response curve is aimed at medical use, however it can be used for other applications. The goal of the DICOM response curve is to have a visually linear display response.
- **Custom Curve** - Advanced and custom response curves can be selected from presets or created by importing a table of values. Click the Edit... button to open the Custom Gamma Curve dialog.

Note: The Custom Curve and DICOM Curve selections will not be available if the current Calibration Method is set to Use RGB Gains in the Preferences.

Contrast Ratio

Contrast Ratio allows a particular contrast ratio to be used if necessary. The contrast ratio is the ratio of white to black luminance.

Selecting Default will calibrate the display to the highest possible contrast ratio, which is limited by the display technology, the selected White Point, Intensity value, and other factors.

In some applications, for example simulating low contrast images such as in newsprint, it is useful to have a lower contrast ratio than the display’s native value. Contrast Ratios in the range of 50:1 to 500:1 can be selected.

Note: If the selected contrast ratio is higher than what the display is actually capable of achieving, then the display will calibrate to the highest possible contrast ratio. If a specific Contrast Ratio is selected, it is recommended that the number of Calibration and Measurement Steps be set to at least 32 in the Preferences dialog.

Note: The Contrast Ratio selection will not be available if the current Calibration Method is set to Use RGB Gains in the Preferences.
Custom Gamma Curve dialog

The **Custom Gamma Curve** dialog is accessed by clicking the **Edit..** button in the **Gamma Curve** section of the **Edit Calibration Target** dialog.

Advanced response curves can be selected from presets or custom curves can be created by importing a table of values.

The following preset curves are available:

- **sRGB** - A curve based on the sRGB specification that includes the offset, transition and slope components.
- **L\*** - A curve based on L\* in the Lab specification. The L\* curve is intended to be more perceptually uniform than a simple gamma value curve.
- **Video** - A curve based on the SMPTE-170M specification for NTSC that includes the offset, transition and slope components. Also suitable for PAL, SECAM and HDTV applications.
- **SMPTE-240M** - A curve based on the SMPTE-240M specification for 1125 line HD video that includes the offset, transition and slope components.

Custom curves can be created and imported into *NEC Display Wall Calibrator* by creating a text file with a list of numerical values. The text file must conform to the following specifications:

- Must contain between 3 and 256 values.
- Each value must be on a separate line.
- The first value must be 0.
- Values must be monotonically increasing.

When imported, the values will be automatically scaled and interpolated to create a Target curve.

*Note: The Custom Gamma Curve option will not be available if the current Calibration Method is set to Use RGB Gains in the Preferences.*
Custom White Point dialog

The **Custom White Point** dialog is accessed by clicking the *Edit* button in the **White Point** section of the **Edit Calibration Target** dialog.

A custom White Point can be created by either specifying it as a *Black Body* radiator temperature in Kelvin, as **CIE (xy chromaticity) Coordinates**, or by taking a measurement.

Values between 2500K and 10000K may be entered in the Black Body K field. The corresponding CIE xy coordinates are automatically calculated and displayed for reference.

CIE xy chromaticity coordinates can be entered by selecting the **CIE Coordinates** radio button and entering the x and y values. The corresponding correlated black body radiator temperature and Δuv (Delta-uv) values are automatically calculated and displayed for reference. The Delta-uv value indicates how far the xy coordinates entered are from the black body radiator locus.

A custom White Point may be measured using the calibration sensor, and automatically entered in the CIE xy chromaticity coordinate fields by clicking the *Measure* button. This is useful for "cloning" the white point of another display monitor.
Preferences dialog

The Preferences dialog is accessed from the Edit menu, and is divided into 3 different tabs. The default settings for the entire Preferences can be restored by clicking the Defaults button.

Preferences dialog - Calibration Sensor tab

Sensor Type - Selects the model of calibration sensor to use, and shows the current model being used.

Auto-Detect - Attempts to detect the selected model of calibration sensor. NEC Display Wall Calibrator will automatically detect the calibration sensor when the application is started, however if the sensor was not connected at that time, or if it was being used by another application, then it may be necessary to re-detect it.

Note: If the sensor was not attached when NEC Display Wall Calibrator was launched, then it may be necessary to exit the NEC Display Wall Calibrator application and launch it again. In some cases it may be necessary to re-connect the USB sensor for it to be detected.

Model and Serial Number - Shows the model and serial number of the currently selected calibration sensor device.
Calibration and Profile Steps - Selects the number of measurement steps to take when calibrating the display. A larger number of steps will generally result in a more accurate grayscale calibration, but will increase the calibration time. 16 steps is the recommended setting for most applications.

Note: The Calibration and Profile Steps selection will not be available if the current Calibration Method is set to Use RGB Gains.

Intensity Adjustment - Sets how a particular Intensity value is achieved during the calibration process if necessary.

Options are:

- **Use Brightness Control** - The Brightness control on the display is used if necessary to achieve the target Intensity. This will provide the best possible Contrast Ratio and also lowest power consumption (assuming the target Intensity used results in the brightness control being reduced from maximum). Adjusting the Brightness control can increase the calibration time slightly, and the Intensity may drift slightly after being adjusted. Because the range of the Brightness control is limited, any additional adjustments necessary to achieve the target Intensity are done using the internal LUTs.

- **Leave Brightness Control at Maximum** - The Brightness control on the display is set to the maximum value and any adjustments necessary to achieve the target Intensity are done using the internal LUTs. This may give a slightly lower calibrated Contrast Ratio, and the display power consumption will always be highest. The calibration time is fastest for this method.

- **Do not adjust Brightness Control** - The Brightness control on the display will not be adjusted from the current setting. Any adjustments necessary to achieve the target Intensity are done using the internal LUTs if possible. This option allows the Brightness to be manually adjusted before calibration if necessary. Since the Brightness control is not adjusted, the Intensity can not be increased if necessary during calibration.

Extended luminance stabilization time - Increases the waiting time for the display to stabilize while the luminance is being adjusted by using the Brightness control. This option can be used if necessary to increase the accuracy of the luminance adjustment when a Target with a Specific Level of Intensity is being used. It may significantly increase the calibration time, and is normally only useful when a very low intensity value is used. Try selecting this option if the Intensity measured after calibration is significantly different than the Target value due to the display stabilizing during the calibration and profiling steps.
Preferences dialog - Advanced tab

**Calibration Method** - Selects the how the calibration is performed in each display. Options are:

- **Use LUTs** - Uses LUTs (Look Up Tables) in the display to adjust the white point and grayscale correction. It uses an internally generated test pattern when measuring the display. Custom gamma curves and contrast ratios are possible. This method is slower than the Use RGB Gains method because there are more measurement steps, and the LUT must be transmitted to each display.

- **Use RGB Gains** - Uses the Red, Green and Blue Gain controls on the display to adjust the white point to the incoming video signal. A 100% white signal must be displayed during calibration. This method is faster, but does not calibrate individual points along the grayscale. Also certain gamma curves cannot be used (only Native, 2.2 and 2.4 are supported).

See the **Calibration Method Comparison** section for a more detailed explanation, and how best to choose which to use.
Preferences dialog - Interface tab

**Luminance Units** - Selects the units that luminance values are displayed in. Options are:

- Candelas (cd/m²)
- Foot Lamberts (fL)

**Check For Updates** - When selected, the software will automatically check every two weeks when run to see if a new version is available online. An Internet connection is required.

**Play voice prompts during calibration** - When selected, the software will play voice prompts during the calibration process indicating when to position and remove the color sensor from the display screen. This is useful when it is not practical to look at the application while the displays are being calibrated. A PC with sound output capabilities is required.
Panels

Various Panels are available within the main window for controlling the operation of the software and for setting and viewing the status of various settings.

Panels can be closed either by selecting them from the View menu, or clicking the close icon on each panel. Panels can also be rearranged and even moved outside of the main window if desired, by dragging the title bar of the panel.

The functions of each panel are described in detail below:

**Actions panel**

This panel is used to perform the major operations in the application. The various buttons will be disabled and enabled depending on the stage of the calibration process.

Generally operations for calibrating the display are done in the same order as the buttons.

- **Verify Selected** - This will attempt to communicate with the currently selected display in order to verify that it is accessible and correctly configured. If a display fails this step, then follow the troubleshooting guide in chapter 7. Once all displays have been verified, it is possible to go on to the Initialize step.

- **Verify All** - This is the same as **Verify Selected**, but attempts to communicate with all displays.

- **Initialize Selected** - This will reset the selected display to the default color settings so that the “native” performance of each display can be measured before the calibration. Settings such as the Brightness, Color mode, Contrast etc. will be reset.

- **Initialize All** - This is the same as **Initialize Selected**, but will reset each display in the project.

- **Measure Selected** - This will measure the default “native” color characteristics of the currently selected display. These measurements will determine the maximum possible Intensity that will give a color match with all the displays. You will be prompted to place the sensor on the screen while the software displays various test patterns and takes measurements.

- **Measure All** - This is the same as **Measure Selected**, except that all displays will be measured sequentially. You will be instructed which display to place the color sensor on while the software displays various test patterns and takes measurements. This will repeat until all displays are measured.

There is no need to interact with the host PC while the displays are being measured with this option, since the next display is selected automatically and the routine will wait until the color sensor is placed on the screen indicated. This is useful if it is not convenient to have the host PC nearby, for example when standing on a ladder.

- **Calibrate Selected** - This will calibrate the currently selected display to the Target settings. You will be prompted to place the sensor on the screen while the software displays various test patterns and takes makes adjustments.

- **Calibrate All** - This is the same as **Calibrate Selected**, except that all displays will be calibrated sequentially. You will be instructed which display to place the color sensor on while the software displays various test patterns and makes adjustments. This will repeat until all displays are calibrated.

There is no need to interact with the host PC while the displays are being calibrated with this option, since the next display is selected automatically and the routine will wait until the color sensor is placed on the screen indicated. This is useful if it is not convenient to have the host PC nearby, for example when standing on a ladder.

- **Visual Trim Selected** - This feature can be used to manually make very fine color adjustments to the currently
selected display by adjusting the color visually. It is useful for example when the automatic calibration doesn’t match the displays perfectly.

**Action button tooltips**

Each button has a tooltip which shows the steps and conditions necessary for it to be enabled. Hold the cursor over a button and the tooltip will list the conditions. A green check mark indicates that a condition has been met. A red cross mark indicates that a condition has not yet been satisfied. When all conditions have been satisfied the button will be enabled.
Connection panel

This panel is used to modify the communications connection settings for the currently selected display in the layout.

Connection types of **RS232** or **LAN** (Ethernet) can be selected.

If using RS232, the RS232 COM port on the host PC used to communicate with the displays can be selected. Currently available COM ports on the host PC are listed in **COM Port**.

Otherwise, if using LAN, the **IP Address** of the display can be entered. See Chapter 8 for instructions on how to assign the IP address for each display.

For both communications types, the **Monitor ID** of the display must be selected and this must match the ID selected on the display's OSD setting. If displays are daisy-chained together using RS232, each display must have a unique Monitor ID assigned that must match that set on the display's OSD setting.

The communications settings and link to the display can be tested by clicking the **Test** button. This will attempt to communicate with the display on the selected communications interface and Monitor ID.

Clicking the **Update** button will update the communications connection settings for the currently selected display in the layout.

**Note:** If changes have been made, but the **Update** button has not been clicked, then the changes will be lost if another display is selected in the layout.

**Note:** Microsoft Windows version only - COM ports 1-16 are listed, regardless of if they are installed on the system. COM ports that are reported as installed by Windows are shown with a green check mark ✓. Some RS232 adapters do not correctly identify themselves to Windows and may not show the green check mark.

Calibration Target panel

This panel shows the Calibration Target settings that will be used when the displays are calibrated.

The Calibration Target settings can be modified by clicking **Edit...** which will open the **Edit Calibration Target** dialog.

**White Point** shows the Target White Point.

**Gamma** shows the Target gamma or Tone Response Curve type.

**Intensity** shows the Target display intensity adjustment method and value.

**Note:** When using the **Maximum Possible Matching** method for **Intensity**, the actual value used to calibrate all of the displays will not be shown until all of the displays have been measured, and the Target calculated.

**Contrast Ratio** shows the Target contrast ratio.
Colorimeter panel

This panel allows measurements of colors displayed on the screen to be taken with the calibration sensor and the numerical results are displayed.

To take color measurements using the Colorimeter, display a white image on the screen to be measured and place the calibration sensor on the screen. Then click the Measure button to take a single color measurement and display the results.

The measurement results are shown in CIE xyY and Color Temperature.

The Color Temperature field shows the corresponding correlated black body radiator temperature of the measurement in Kelvin. The Δuv (Delta-uv) value indicates how far the measurement is from the blackbody radiator locus. The Kelvin value is only meaningful for colors that are near the black body radiator locus, such as most shades of white.

This feature can be used together with the Test Patterns tool to verify the calibration accuracy of a display. In this case the Calibrated White function in the Test Pattern panel can be used to show a calibrated white screen, then the sensor can be used to measure the screen.

It can also be used to measure the native white point of a display by using the 100% White function in the Test Pattern panel to show a native white screen, which can then be measured using the sensor.
Test Pattern panel

This panel is used to display test patterns on either the currently selected display, or all of the displays in the layout.

Test patterns can be used to visually evaluate the displays both before and after calibration.

Three patterns are available:

- **100% White**, **Calibrated White**, and **Visual Trim+Calibrated White**.

The **100% White** pattern is native white with no correction applied by the calibration.

The **Calibrated White** pattern is only available if the display has been calibrated. It displays the adjusted white color achieved after calibration. It is useful to visually evaluate the calibration accuracy. This does not apply any Visual Trim adjustments made to any of the displays, so the resulting test pattern shows the results achieved by automatic calibration alone.

The **Visual Trim+Calibrated White** pattern is the same as Calibrated White, however any adjustments made using the **Visual Trim** feature are also applied.

- **Off** will turn off the test patterns, and normal video will be shown.

- **Apply to**: selects if the Test Patterns will be shown on either only the **Selected Display**, or **All Displays**.

**Note:** Since there is a slight color shift with viewing angle, when evaluating the color calibration uniformity across multiple displays, be sure to stand as far back as possible from the video wall, and evaluate from directly in front of the screens.

**Note:** The **Calibrated White** and **Visual Trim+Calibrated White** buttons will not be available if the current **Calibration Method** is set to **Use RGB Gains** in the **Preferences**. In this case a white video signal must be used to evaluate the calibrated white instead of using the internally generated test patterns.
This panel is used to reset and restore measurements and settings.

**Reset Measurement Data** - Will clear all of the measurements taken during the Measurement phase of the calibration.

**Reset Calibration Data** - Will clear all of the calibration data including measurements and adjustment settings. It will not reset any settings in the displays.

**Restore Calibration Settings** - Will re-configure displays with the settings from the last calibration. This can be useful to switch between different calibrations by loading different projects, and restoring the calibration data to all of the displays.

Since the calibration settings are stored as part of the Project files, entire wall calibrations can be restored as necessary by loading a Project file, and using this function to restore the calibration settings to the displays.

These functions can either be applied to the selected display, or all displays by selecting the appropriate setting in *Apply to*.
This panel shows the measured White Point values from the color sensor taken during the Measurement and Calibration operations. Both the White Point and Intensity (luminance) are shown as numerical values and graphically.

The **White Point** shows the measured value compared to the Target White Point in CIE xy.

This gives an indication as to the accuracy of the calibration compared to the Target value, as well as how far the display needed to be adjusted from the native state in order to achieve the Target White Point.

The **Intensity** bar shows the measured value. If the Target is a specific value, then red arrows indicate this level on the bar.

**Uncalibrated** - Shows the native or un-calibrated measurement taken during the Measure operation.

**Calibrated** - Shows the corrected or calibrated measurement taken during the Calibration operation.
Tile Matrix Wizard dialog

The Tile Matrix Wizard dialog is accessed from the Edit menu, and is used to automatically configure the Tile Matrix settings on all or some of the displays in the current project. The Tile Matrix feature can be used to divide and expand video sources over multiple displays using internal processing in each display.

Tile Matrix Wizard Introduction.

The Wizard can be used to enable a single tile matrix across all displays in the current project, or to configure multiple groups of displays within the project, or to disable Tile Matrix on all displays.

The Wizard will automatically calculate and configure the settings for the tile matrix horizontal and vertical sizes, and the matrix position for each display.
If the video wall is to be divided into multiple groups of displays then the displays in each group can be selected.

First click on the square representing the top left display, then click on the one representing the bottom right display.

Click Next to proceed to the next step.

The Tile Matrix settings are sent to the displays on the final page of the Wizard by clicking the Update Displays button.

Selecting Use Tile Comp enables the Tile Comp feature which compensates for the display bezel width when the video is divided across displays.

If more groups need to be configured, click the Back button and select the next group of displays. Repeat until all displays have been configured.
Display Settings dialog

The **Display Settings** dialog is accessed from the **Edit** menu, and is divided into 5 different tabs. Various settings on the displays can be set and read from this dialog. Settings can be applied to either a single display, or to all of the displays in the current project by selecting either **Display** or **All Displays**.

**Note:** When **All Displays** is selected, some controls are not updated until the associated update button is clicked.

Display Settings dialog - Power tab

![Display Settings dialog - Power tab](image)

The **Power** tab controls the power settings of the displays.

Clicking the **On** button will turn the display or displays on.

Clicking the **Off** button will turn the display or displays off.

When **Display** is selected the current power state of the display is shown.

Power Saving mode can be enabled and disabled for the currently selected video input using **Enable** and **Disable**.

The **Power On Delay** time can be adjusted for individual displays, or for all displays in the entire project. This control sets the time delay is seconds for the display to when the main display circuits are switched on after power on.

By staggering the delay time between displays, a sudden large power rush can be avoided when the video wall is turned on.

When **All Displays** is selected, the software will automatically calculate the staggered delay time for each display in the project according to the selected delay setting.

**Cooling Fan Control** adjusts the cooling fan settings such as fan speed, temperature trigger point, and forced on or automatic operation.
The **Schedule** tab is used to set the internal real time clock and schedule functions in the display. Various scheduled operations such as power on, power off, and changing inputs can be configured.

The internal clock can be set to the host PC's system date and time by clicking the **Set to system date & time** button.

When **Display** is selected, a custom time and date can be set in the display by modifying the **Time** and **Date** fields and clicking the **Set to custom date & time** button.

When a single display is selected using **Display**, the current time and date of the clock in the display is shown.

Different schedules are selected in the **Program** listbox. Each schedule can be enabled or disabled by selecting **Enable**. On and Off times can be specified and enabled or disabled, as well as the video **Input** and **Picture Mode** (if supported by the display). Settings are updated by clicking the **Update** button.
Display Settings dialog - Input tab

The **Input** tab is used to set and report the current video input selected on the display, and also the IR Control setting.

When a single **Display** is selected the **Video Input** list shows the current video input being used by the display. The video input can be changed by selecting the desired input from the list.

When **All Displays** is selected the **Video Input** list does not show the current video input. The video input can be changed for all of the displays in the project by selecting the desired input from the list and clicking the **Update** button.

**IR Control** selects the mode for using the infra-red remote control to control multiple displays when using an RS232 daisy chain between displays.

When **Normal** is selected, the monitor will be controlled normally by IR remote controller.

Select **Primary** on the first display in an RS232 daisy chain configuration to use it as the IR Receiver for all of the displays. Select all of the other displays on the daisy chain to **Secondary**. The Primary display will forward IR commands received from the sensor to the other displays via RS232.

Select **Lock** to prevent operation of the IR remote receiver.
Display Settings dialog - Video tab

The **Video** tab is used to perform video signal and color adjustments.

The following two controls are only available when analog video inputs such as VGA, RGB/HV, and Option-Analog. It is not necessary to re-calibrate the displays after performing these operations.

**Analog Auto-Setup** will measure the incoming analog video signal and automatically set the video level controls in the display as well as the size and position of the video.

This operation should only be performed whenever a new analog video signal is connected, when a major change is made to the video wiring to the display, or when a video amplifier or splitter is added to the video link.

*Note:* It is essential that when this operation is performed a video signal that contains both pure black and pure white is being input. White video should extend to each edge of the active video area, otherwise the controls may not be adjusted correctly by the display. A sample test pattern is installed with the software and should be displayed full-screen on the video source input.

**Analog Auto Bias/Gain Setup** will measure the incoming analog video signal and automatically set the video level bias and gain controls in the display.

This operation should be performed if there is a color tint on black video after the display has been calibrated.

*Note:* It is essential that when this operation is performed a color bar test pattern video signal is input, otherwise the controls may not be adjusted correctly by the display. A sample test pattern is installed with the software and should be displayed full-screen on the video source input.

The **Brightness, Contrast, Sharpness, Black Level, Tint and Color** controls adjust the settings for the respective video controls in the display.

*Note:* Changing the settings for these controls may impact the color accuracy and matching of the video wall color calibration.

The **Edge Comp** controls adjust the edge mura compensation settings in the display (if supported).
The **Calibration** tab is used to apply the various calibration settings to video inputs other than the input that was selected when the display was calibrated.

Each video input can have its own settings for various controls, such as Brightness, Gamma Selection, Picture Mode etc.

During calibration, the settings for the currently selected video input are automatically configured. However if at some point in time other types of video inputs will be used with the video wall, then the settings for those inputs will need to be correctly configured to use the calibrated settings.

Select the video inputs to apply the calibrated settings to and click the **Apply** button.
The **Status** tab reports various aspects about the currently selected display. This feature is not available when **All Displays** is selected.

**Operating Hours** - Shows the number of hours that the currently selected display has been in operation.

**Firmware version** - Shows the version number of the firmware in the display.

**Fan 1, 2, and 3** - Shows the current operating status of the internal cooling fans of the display. On, Off and Error conditions are reported. The fan settings can be adjusted on the **Power** tab.

**Temperature Sensor 1, 2, and 3** - Shows the current internal temperature sensor readings of the display.

**Diagnostics** - Shows the diagnostic condition reported by the display, as well as various failure conditions such as power supply, fan, and temperature abnormalities.

**Horizontal, Vertical Video Frequency, Video Sync** - Shows the video frequency and sync polarity of the current video input.
Display Settings dialog - Tile Matrix tab

The **Tile Matrix** tab can be used to configure the Tile Matrix settings for dividing and expanding a video source over multiple displays.

**Enable Tile Matrix** - Is used to enable the Tile Matrix feature in each display.

**Matrix size** - Is used to set the matrix size in rows and columns.

**Use Tile Comp** - Enables the Tile Comp feature to compensate for the display bezel width when the video is divided.

When a single display is selected, the position in the tile matrix can be selected by clicking the relevant display on the matrix diagram.

The **Tile Matrix Wizard** can be used to automatically configure the Tile Matrix settings for all displays in the project.
The **Size/Position** tab can be used to configure the various video size and position settings in the display. When **All Displays** is selected, controls are not updated until the associated update button is clicked.
The **IR Remote** tab can be used to perform the equivalent operations as the physical IR Remote control using the software and communicating using the LAN or RS232 connection to the display.

This is useful when it is not practical to use the actual IR Remote control with the display, or when it is necessary to access controls by remote that are not available from within the software.

Select the display to control from the **Apply To Display** list. Click the buttons to send the IR Remote command to the display. The display will respond as if it received a signal from the IR Remote control.

Sequences of commands can be created and sent to the display at once by clicking the **Send Sequence** button. The IR Remote command code will appear in the Code Sequence list and can be manually edited. Each IR Remote button is a single 2 hex digit code.

To prevent each IR Remote command codes from being sent to the display as each button is pressed, deselect the **Send Immediately** checkbox.
The **Advanced Analog** tab can be used set special video adjustment patterns used to assist with manual adjustment of the analog video input levels.

This advanced feature should only be used in cases where:

1. The Calibrated White test patterns match satisfactorily, but a white analog video signal input does not. If the Calibrated White test patterns do not match, either recalibrate or use the **Visual Trim** function to manually adjust each display slightly.

2. The automatic **Analog Auto Bias/Gain Setup** control on the **Video** tab is not able to provide an accurate enough adjustment of the analog video signal.

See the **Advanced Analog Adjustment** chapter for a detailed step by step guide on how to use this function.
Summary window

The Summary window is accessed from the View menu.

### Connection Summary:
- **Port** - Shows the Communications Port to the display, either the RS232 COM Port, or LAN IP Address.
- **Monitor ID** - Shows the Monitor ID used to identify the display monitor.
- **Model** - Shows the model of the display monitor.
- **Serial Number** - Shows the serial number of the display monitor.
- **Firmware Version** - Shows the version of internal firmware of the display monitor.
- **Status** - Shows the current status of the display monitor in the measurement and calibration process.

### Calibration Summary:
- **Uncalibrated Intensity** – Shows the measured native Intensity (luminance) of the display when un-calibrated.
- **Uncalibrated White Point** – Shows the native white point of the display when un-calibrated.
- **Uncalibrated Contrast Ratio** – Shows the native contrast ratio of the display when un-calibrated.
- **Maximum Calibrated Intensity** – Shows the calculated maximum Intensity that can be achieved by the display using the current Target White Point setting. If the current Target Intensity method is set to Specific Level and the calculated value is more than 5% lower than the Target, then a yellow warning icon is shown to warn that the displays may not match in Intensity after calibration using the current Specific Level value, and a lower value should be chosen.
- **Date Measured** – Shows the date and time that the un-calibrated measurements were taken.
- **Operating Hours when Measured** – Shows the number of hours the display has been in operation at the time the un-calibrated measurements were taken.
- **Actual Calibrated Intensity** – Shows the Intensity (luminance) of the display after it has been calibrated. If the current Target is set to Maximum Possible Matching or Specific Level and the value is not within 10% of the Target Intensity value, then a yellow alert icon is shown to warn that the display could not achieve the desired Target Intensity value when calibrated.
- **Actual Calibrated White Point** – Shows the white point that the display was adjusted to after calibration.
- **Date Calibrated** - Shows the date and time when the calibration was performed.
- **Operating Hours when Calibrated** – Shows the number of hours the display has been in operation when the calibration was performed.

This window shows the current layout configuration and connections, as well as detailed information about the calibration results.
calibration was performed.

*Brightness Setting* – Shows the OSD Brightness setting value that the display was adjusted to when the calibration was performed.
Menus

File menu

*New Project* - Creates a new project and erases all of the current data.

*Open Project...* - Opens an existing Project file.

*Save Project* - Saves the current Project to a file.

*Save Project As...* - Saves the current project with a new file name.

*Exit* - Closes the application.

Additionally, up to the last 5 projects opened will be listed on the File menu for convenience.

Edit menu

*Preferences...* - Opens the *Preferences* dialog.

*Layout Wizard...* - Opens the *Display Layout Configuration Wizard*.

*Tile Matrix Wizard...* - Opens the *Tile Matrix Configuration Wizard*.

*Calibration Target...* - Opens the *Edit Calibration Target* dialog.

*Display Settings...* - Opens the *Display Settings* dialog.

View menu

*Summary* - Opens or closes the *Summary* window.

*Connection* - Hides or shows the *Connection* panel.

*Calibration Target* - Hides or shows the *Calibration Target* panel.

*Colorimeter* - Hides or shows the *Colorimeter* panel.

*Display Measurements* - Hides or shows the *Display Measurements* panel.

*Test Pattern* - Hides or shows the *Test Pattern* panel.

*Status* - Hides or shows the *Status* panel.

Tools menu

*Verify Monitor Firmware...* - Queries each display and checks if the internal firmware is compatible with *NEC Display Wall Calibrator*. Any displays that do not have the minimum level of firmware will be listed and must have the firmware updated before calibrating.

*Verify RS232 COM Port...* - Checks if the RS232 COM port adapter on the host system is capable of transmitting and receiving data to the displays correctly. Some adapters do not have a sufficient data buffer and will cause communications to fail under certain conditions.

Help menu

*About...* - Displays the *About* dialog box which shows the software version number.

*Check for updates...* - Contacts the NEC Display Solutions website and checks to see if a newer version of *NEC Display Wall Calibrator* is available. If a newer version is available, information about the version and download links will be shown. An Internet connection is required for this feature to operate.
Quick Start to NEC Display Wall Calibrator

1. Install Software
Install the NEC Display Wall Calibrator software on the host PC. The serial number provided on either the CD-ROM cover, or with your purchase will be required to install the software.

2. Connect color sensor
Connect the color sensor to a USB port on the host PC and verify the drivers are installed correctly.

3. Warm up displays
Power-on each of the displays in the video wall. The displays should be warmed up for at least 30 minutes before calibrating.

4. Configure and connect displays
It is not necessary to connect the video output from the PC to any of the displays. The only connection to the displays will be either RS232 and/or LAN (Ethernet). Wireless LAN can also be used from the host PC if using a wireless access point or router.

See chapter 3 for detailed information about the various connection configurations.

5. Select the desired Calibration Method
In the Preferences dialog, on the Advanced tab, select the desired Calibration Method. The choice of selection will depend on the type of video wall application being used, and the desired calibration results. See Calibration Method Comparison section for a detailed explanation of the two different Calibration Methods, and how best to choose which to use.

6. Define Video Wall Layout and Connections
Use the “Layout Wizard” from the Edit menu to specify the number of displays, their layout, calibration order, and connection method.

If necessary modify the connection settings for any display by using the Connection panel.

7. Verify Communications
Test the communications to all the displays by clicking the Verify All button on the Actions panel. This will attempt to communicate with each display in the layout.

If there is an error in verifying communications with a display, see the troubleshooting guide in chapter 7:

As each display is successfully tested, its rectangle in the main window will change from Yellow to Cyan. Once all displays are verified, it is possible to continue on with the next stage of the calibration process.

8. Verify Monitor Firmware
Verify that each display has the correct firmware in order to correctly support using NEC Display Wall Calibrator. Select Verify Monitor Firmware from the Tools menu. Any displays that do not have supported firmware versions will need to be updated. Contact NEC Display Solutions for the latest firmware.

9. Initialize Display Settings
Click the Initialize All button on the Actions panel to reset the color settings on each display to the default state.

10. Measure displays with default settings
If Maximum Possible Matching is selected as the Intensity adjustment method in the current Calibration Target, it
will be necessary to measure the color characteristics of each display so the software can calculate how to match all the displays. These measurements will determine the maximum possible Intensity that will give a color match with all the displays.

Click the *Measure All* button on the *Actions* panel to start the measurement process. You will be prompted to place the sensor on the screen of each display in turn. The display to place the sensor on will flash alternate red and green colors until the sensor has been positioned on the screen. Place the sensor flat against the center of the screen, and hold it steady while applying the minimum force possible.

The software will then automatically measure the display characteristics which will take about 30 seconds. When complete, the next display to be measured will flash and this process will continue until all displays are measured.

As each display is successfully measured, its rectangle in the main window will change from Cyan to Magenta.

11. **Define the Calibration Target**

Select *Calibration Target…* from the *Edit* menu, or click the *Edit…* button in the *Calibration Target* panel to open the *Edit Calibration Target* dialog. The default values are suitable for most applications. If necessary for a particular application, custom settings for the method of Intensity adjustment, desired White Point, Gamma value, and Contrast Ratio can be selected.

12. **Calibrate displays**

Click the *Calibrate All* button on the *Actions* panel to start the calibration process. You will be prompted to place the sensor on the screen of each display in turn. The display to place the sensor on will flash alternate red and green colors until the sensor has been positioned on the screen. The software will then automatically calibrate the display which will take 2 minutes or more.

When complete, the next display to be calibrated will flash and this process will continue until all displays are calibrated.

As each display is successfully calibrated, its rectangle in the main window will change from Magenta to Green.

13. **Evaluate results**

Once the calibration process is completed, the results can be visually evaluated by using the Test Pattern feature. On the *Test Pattern* panel, select *All displays*, and click the *Calibrated White* button.

*Note: Since there is a slight color shift with screen viewing angle, so be sure to evaluate the video wall from a distance and from directly in front.*

Click the *Off* button to turn off the test patterns.

The numerical results of the measurement and calibration process are available by selecting *Summary* from the *View* menu. This window shows the connection settings for all of the displays, including the model and serial number information for each display.

*Important:* If the displays do not match well when showing an analog video signal, this indicates that the analog video signal levels may need to be adjusted to compensate for variations that may cause color shifts between displays. See the *Analog Inputs - Important Notice* for more information.

14. **Visual Trim (if necessary)**

If there are any displays that are not able to be matched accurately enough using the automatic calibration, they can be visually adjusted using the *Visual Trim* feature.

15. **Configure Tile Matrix (if necessary)**

If the displays in the video wall are going to be showing a video source that is divided and expanded across multiple displays using the internal Tile Matrix feature, the Tile Matrix Wizard can be used to easily configure the settings for all the displays.

16. **Save**

Save the project file so it can be used again in the future to re-calibrate the displays when necessary.
Frequently Asked Questions

Calibration

**Question:** Can I use NEC Display Wall Calibrator to calibrate a single display?

**Answer:** Yes. Use the Layout Wizard to create a layout with a 1x1 video wall, and calibrate as normal.

**Question:** How often will I need to use NEC Display Wall Calibrator to re-calibrate a video wall?

**Answer:** The time until the displays need to be re-calibrated will depend on many factors such as the environment and duration they are used, the age of the displays, the calibration Target settings used, and how critical the color matching requirements are. Newer displays will tend to drift more rapidly than displays that have been in use for several days or weeks. Typical re-calibration periods could be six months for most applications and as low as one month for color critical applications.

**Question:** If one of the displays in the video wall is replaced, will it be necessary to re-calibrate the entire video wall?

**Answer:** It depends on the particular type of calibration settings being used, and the performance of the new display compared to the existing displays. If the new display is much brighter than the existing displays, then in most cases it is possible to only calibrate the new display in order to match the others - since it can be adjusted down in luminance to match the other displays.

However if the new display is about the same brightness as the existing displays, or less, then the existing displays may need to be re-calibrated in order to match the new display since it may now be the dimmest display.

Also the existing displays may have drifted since the last calibration so it may be necessary to re-calibrate all of the displays.

**Question:** How can I configure a video wall that is not rectangular in shape?

**Answer:** Create a layout with the maximum number of rows and columns of displays. Then disable the displays in the layout that are not part of the video wall. To disable a display, right click on the icon for the display in the main window and select **Disable.** It may be necessary to manually re-configure the Connection settings for some of the displays since the Layout Wizard will have assigned IP addresses or IDs sequentially for all displays, including the disabled ones.

**Question:** Why can’t I get all of the displays to match perfectly, and what can be done to improve the matching?

**Answer:** The displays may not all match perfectly due to several reasons, such as:

1. The color and brightness uniformity of the screen is never perfect and will vary across the screen area. However the color sensor is only measuring and adjusting the center of the screen.

2. When evaluating displays visually, we tend to look at the joints where adjacent displays meet. The edges of the displays are typically most non-uniform.

3. The color sensor used to measure the displays perceives color slightly differently than the human eye. Colors on two different displays that the sensor measures as being identical in value, may be visually different to the human eye.
4. The color of the LCD displays will vary slightly with viewing angle. So when viewing a video wall, each display will be viewed from a different angle which causes color shifts.

5. The colors on the LCD screen can be temporarily distorted by any pressure applied to the screen. Applying too much pressure to the color sensor during calibration can cause inaccurate color matching.

In order to try and improve the color matching between displays after they have all been calibrated, first try recalibrating the worst matching display(s). If this does not improve the matching, then use the Visual Trim feature to make minor changes to the display visually.
Installation and Setup

**Problem:** Measure and Calibrate buttons are disabled.

**Solution:** The Measure and Calibrate buttons are disabled for any of the following reasons:

- No supported calibration sensor was detected.
- No supported display monitor was detected.
- All of the displays have not yet been Verified.

**Problem:** Verify Communications operation fails.

**Solution:** Check that:

- Each display is correctly configured to use either the LAN or RS232 interface by confirming the EXTERNAL CONTROL setting on the OSD menu.
- The MONITOR ID is set correctly on the OSD and matches the value assigned in the software.

If using RS232:

- If using daisy-chaining, confirm that no other displays on the same chain have the same MONITOR ID.
- Make sure that each display is connected via a NULL modem cable and that the correct IN or OUT socket on the display is used.
- Make sure that no other application or process is using the specified COM port.

If using LAN:

- Make sure that the IP address of each display is set correctly and that each display has a unique IP address.
- Make sure that the IP address assigned to each display matches those assigned in the software.
- Make sure that no other device on the LAN is assigned the same IP address.
- The IP address of each display must be configured using a web browser. The default IP address is 192.168.0.10.
- Make sure that the displays are on the same subnet as the host PC being used.
- Make sure that there are no firewall settings or antivirus applications that may be preventing the application from accessing the LAN.
Calibration

Problem: When switching to different video inputs the displays no longer match.

Solution: Each video input can have its own settings for various controls, such as Brightness, Gamma Selection, Picture Mode etc.

During calibration the settings for the currently selected video input are automatically configured. However if other video inputs are going to be used as well with the video wall, then the settings for those inputs will need to be correctly configured to use the calibrated settings.

Use the Calibration tab on the Display Settings dialog to apply the calibration settings to other video inputs.

Problem: When showing the Calibrated Test Pattern the displays in the video wall match. However when an analog video signal is shown they no longer match.

Solution: Differences in the analog video signal level between displays may cause the displays not to match.

The Auto-Setup operation should be performed on each display which will measure the incoming analog video and automatically set the video level controls in the display.

This operation may need to be performed each time a new analog video signal is connected, or if a major change was made to the video wiring to the display, or a video amplifier or splitter was added to the video source.

Auto-Setup can be accessed from the OSD on each display or by using the Video tab in the Display Settings dialog available from the Edit menu.

Note: This adjustment process requires specific patterns to be displayed on the video signal in order for the display to automatically adjust the video signal levels correctly. Failure to display the correct signal may result in the video levels being incorrectly set and the displays may not match in color when using an analog video source.

Problem: “Error: No reply from the display” message is shown during the calibration when using a USB to RS232 adapter.

Solution: Certain models of USB to RS232 adapters may not function correctly with NEC Display Wall Calibrator and may cause an “Error: No reply from the display” message during the calibration process. The display will be detected correctly, but the calibration will fail at a certain point.

This issue is caused by an incompatibility with the USB to RS232 adapter and drivers that causes long messages sent to the display to not be transmitted correctly.

If you encounter this error, please check with the hardware vendor to see if newer device drivers are available. If this does not solve the issue, try using a different model of USB to RS232 adapter.
**Color Sensor**

**Problem:** Software is unable to detect the X-Rite ColorMunki

**Solution:** If the X-Rite ColorMunki software is installed, it will prevent NEC Display Wall Calibrator from accessing the device even if the main ColorMunki application is not currently running.

If you are using the ColorMunki software prior to version 1.1.0

- NEC Display Wall Calibrator will detect if the ColorMunki software is running and give the option of closing it automatically.
- To use the ColorMunki software again after NEC Display Wall Calibrator has closed it, you must run the colormunki.exe application from the Startup menu in Windows.

If you are using the ColorMunki software version 1.1.0 or newer:

- You must turn off the ColorMunki Service in the Windows Control Panel > “X-Rite Device Services” to allow NEC Display Wall Calibrator to access the device.
- To use the ColorMunki software again you must turn the ColorMunki Service back on.

**Problem:** When calibrating or measuring a display, the software becomes stuck with the message “Detecting sensor on display”.

**Solution:** The software detects that the sensor is positioned on the correct display by flashing alternate red and green patterns on the display and taking measurements with the color sensor. If valid color measurements are not detected then the calibration or measurement will not proceed. If the color sensor is damaged or has become very inaccurate it may not be able to detect the colors correctly. It may be necessary to replace the color sensor.

**Problem:** DataColor Spyder 3 color sensor is not detected (Windows only).

**Solution:** The device drivers may not be installed. Open the Windows device manager and locate the Spyder 3 device. Select Update Drivers and provide the location of the drivers. The driver files are copied during installation to the following folders:

On 32 bit Windows:

- C:\Program Files\NEC Display Solutions\NEC Display Wall Calibrator\Drivers\Spyder3

On 64 bit Windows:

- C:\Program Files (x86)\NEC Display Solutions\NEC Display Wall Calibrator\Drivers\Spyder3

If the drivers are not installed in this location, reinstall NEC Display Wall Calibrator and make sure the option to install the Spyder 3 drivers is selected.
Assigning an IP address

Displays connected via LAN need to be assigned an IP address so that they can be remotely accessed. Each display with a LAN interface has a default IP address of 192.168.0.10. This address must be changed in order to avoid conflicts when other displays are connected to the LAN. When the LAN RESET operation is performed on a display’s OSD, the IP address will be reset to the default value.

Some models of display support setting the network settings directly via the OSD, rather than having to use a web browser. In this case, the following steps can be skipped if the network settings are configured using the OSD menu.

Important Note: It is recommended to reset the power to the display after changing the LAN settings in order for the new settings to be recognized.

Setting the IP address via a web browser:

It is recommended to assign the IP address of a display by connecting a PC directly to the LAN port on the display, or via a LAN HUB while no other devices are connected.

If the PC being used to set the IP address of the display is not currently set to access the subnet that includes the display’s defaults IP address, it will be necessary to temporarily modify the network settings in order to assign the PC a temporary IP address and subnet so that the display can be accessed. Once the display has been configured the PC network settings should be restored.

Open the Network Settings properties of the PC, and select Internet Protocol TCP/IP in the list, then click the Properties button.

Next enter a temporary IP address for the PC, such as 192.168.0.255, and a subnet mask of 255.255.255.0. Click OK and close the Network Settings.
Next open a web browser and go to the URL of the display’s web server by entering:

http://192.168.0.10

This should display the display’s MONITOR NETWORK SETTINGS page.

If this page can not be reached, :

- Confirm that the display is powered on and connected to the PC either directly or via a HUB.
- Confirm that the IP address assigned to the display is at the default value, by performing a LAN RESET from the OSD on the display.
- Confirm that the EXTERNAL CONTROL setting on the OSD is set to LAN.
- Try refreshing the web page in the browser. It may take several refreshes before the display can be found.
- Check if any firewall software or settings on the PC could be preventing access to the display’s IP address.
- Try resetting the power to the display.

Once the web page has appeared, the display’s IP address and subnet mask can be entered and updated in the display. It is highly recommended to assign each display a static IP address so that the IP address will not be reassigned to another device if the network is reset.

**Note:** Once the IP address is updated, the display will no longer be accessible from the current IP address.

Next restore the original network settings on the PC.
Calibration Determination Flowchart

The following flowchart outlines the basic steps in determining if the displays should be recalibrated and if the analog video setup procedures should be performed.

Start

- Have displays been calibrated before?
  - YES: Show the "Calibrated White" Test Pattern
  - NO: Show the "100% White" Test Pattern

- Are factory calibration settings acceptable?
  - YES: Calibrate
  - NO: Perform "Analog Auto Setup"

- Is video source signal analog?
  - YES: Turn off Test Pattern
  - NO: Input video source with 100% white test signal

- Do the displays match?
  - YES: Finished
  - NO: Recalibrate or use Visual Trim

- Do the displays match?
  - YES: Finished
  - NO: Check video signal source

- Do the displays match?
  - YES: Finished
  - NO: Perform "Advanced Analog Adjustment"
Visual Trim function

The Visual Trim function allows minor adjustments to be made to the results of the calibration process in order to improve the visual matching of the displays in the video wall if necessary. This feature can be used in cases where the automatic calibration was not accurate enough, and some visual differences between displays can be seen with the human eye.

Once a display has been calibrated, the Visual Trim button will be enabled in the Actions panel.

*Note:* It is best to evaluate screen matching when displaying a white screen. Use the Test Pattern panel to select the Calibrated White or Visual Trim+Calibrated White patterns.

The white point and brightness of the display can be interactively adjusted using the various controls from within the Visual Trim dialog. Three different types of controls are available, but they all accomplish the same function.

- **By Color Circle** - The color of display can be adjusted by dragging the blue ball control around the color circle. The color tint of the display will change towards the color under the ball position. The keyboard arrow keys can be used to move the ball if more precision is needed.

- **Color Circle Brightness** - The brightness of the display can also be adjusted using the slider control. This adjustment is made by scaling the red, green and blue video levels. It does not adjust the brightness of the LCD backlight.

- **Color Cast buttons** - Clicking the button that best represents the color cast on the display compared to others, will adjust the display to reduce that cast. Each adjustment is small, so several may be necessary to make larger changes.

- **By RGB Percentage** - Adjusting these values changes the ratios of the red, green and blue on the display.
• **Backlight Brightness** - This slider adjusts the brightness of the LCD backlight instead of scaling the red, green and blue video levels. Note that large adjustments to the backlight brightness may take several minutes to stabilize. The range of adjustment using the backlight is much more limited than using the other brightness control. Adjusting this control will impact the power used by the display.

To remove a Visual Trim adjustment applied to the display, click the *Remove Visual Trim Adjustment* button.

Once the necessary adjustments have been made, click OK to update the display. The Visual Trim adjustment will be stored as part of the project until the next time the display is calibrated. The Visual Trim icon ✿ is shown in the Display layout diagram for any displays that have a visual trim adjustment applied to the calibration.
Advanced Analog Adjustment function

Overview

The Advanced Analog Adjustment function is intended to assist with the manual adjustment of the analog video levels in cases where the automatic adjustment is not accurate enough.

The procedure involves the setting of a special LUT (Look Up Table) within the display which will allow the analog video levels to be accurately set by making manual adjustments via the IR Remote while looking at the screen.

The process should take about 7 minutes or less per display depending on the experience level.

Once this process is repeated for all displays, the analog video levels between the displays should match very closely, resulting in accurate color matching between displays when an analog video input is used.

Important note: This procedure only adjusts the analog inputs of the display and sets the analog-to-digital conversion levels, which determine how analog video is converted to digital within the display. It does not adjust the digital portion of the video signal path. Therefore it is very important to first calibrate the displays and make sure that the Calibrated White test patterns match satisfactorily between displays. This procedure should not be used to try and match displays that do not match when the Calibrated White test patterns are shown. In this case either re-calibrate the display(s), or use the Visual Trim feature.

Requirements:

- The video input used must be analog, and should use the same signal source, video resolution, cables, distribution amplifiers, etc. that will be used for the final installation.
- The video signal source must be capable of outputting a completely black signal, and a full white signal.
- On some display models the controls for adjusting the necessary settings will be available and enabled on the Advanced Analog tab in the Display Settings. The Analog Offset Base (Bias) Red, Green, and Blue slider controls be used instead of using the OFFSET BASE 01-03 OSD settings, and the Analog Gain Red, Green, and Blue controls can be used instead of the GAIN 01-03 OSD settings respectively.
- On other models, you must have access to each display’s OSD (On Screen Display), either via a physical IR Remote, or by using the IR Remote emulation function in the Display Settings dialog. Using the IR Remote emulation can be slow to make many adjustments, so using a physical IR Remote is recommended if possible.
- Displays should be warmed up for at least 30 minutes before making these adjustments.

Adjustment steps:

1. Connect the analog signal source, and select the correct input on the display.

2. Input a 100% black video signal.

3. In the software, select the Advanced Analog tab in the Display Settings dialog. If the Analog Offset Base and
**Analog Gain** slider controls are enabled, then the display model supports adjustment of the settings via software, and skip to step 6. Otherwise, click the *Enable Expert OSD Mode* button to enable access to this OSD menu.

4. Use either an IR remote or the IR Remote emulation (see other tab) to display the OSD. If the Expert Mode OSD has been successfully enabled, the OSD will show “EXPERT” in the top right corner. The Expert OSD menu is accessed by navigating to the right-most menu, then navigating one more step right.

5. On the EXPERT OSD menu, navigate to the AUTO BIAS GAIN control.

6. In the software, click the *Black LUT* button to load the special LUT. This process will take less than 1 minute. When completed the screen may start to display some video noise - this is normal.

7. The aim of the next step is to adjust the red, green and blue Offset Base (Bias) settings correctly until the screen is full of bright white noise. If the slider controls are available, adjust the Analog Offset Base controls, otherwise the the OFFSET BASE 01 (red), OFFSET BASE 02 (green), and OFFSET BASE 03 (blue), values on the OSD.

Use the IR Remote or IR Remote emulation feature to adjust the OFFSET BASE values up and down.

As the setting value nears the ideal setting, the color being adjusted will start to show as noise. The red, green, and blue noise will combine to make white noise.

The following table shows how the screen color will change as the OFFSET BASE values are adjusted:

<table>
<thead>
<tr>
<th>SCREEN COLOR</th>
<th>OFFSET BASE 01 Value</th>
<th>OFFSET BASE 02 Value</th>
<th>OFFSET BASE 03 Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>INCORRECT</td>
<td>INCORRECT</td>
<td>INCORRECT</td>
</tr>
<tr>
<td>Red Noise</td>
<td>OK</td>
<td>INCORRECT</td>
<td>INCORRECT</td>
</tr>
<tr>
<td>Green Noise</td>
<td>INCORRECT</td>
<td>OK</td>
<td>INCORRECT</td>
</tr>
<tr>
<td>Blue Noise</td>
<td>INCORRECT</td>
<td>INCORRECT</td>
<td>OK</td>
</tr>
<tr>
<td>Yellow Noise</td>
<td>OK</td>
<td>OK</td>
<td>INCORRECT</td>
</tr>
<tr>
<td>Cyan Noise</td>
<td>INCORRECT</td>
<td>OK</td>
<td>OK</td>
</tr>
<tr>
<td>Magenta Noise</td>
<td>OK</td>
<td>INCORRECT</td>
<td>OK</td>
</tr>
<tr>
<td>White Noise</td>
<td>OK</td>
<td>OK</td>
<td>OK</td>
</tr>
</tbody>
</table>

Note that screen may be very noisy and it may difficult to get a pure white screen. Adjust each control until as pure a white screen as possible can be obtained.

**Note:** Do not adjust the OFFSET 01, 02, or 03 settings.
**Hint:** If no noise is visible on the screen after adjusting the OFFSET BASE controls through the entire control ranges, check that a black signal is being input.

Examples:

8. Input a 100% white video signal from the analog source.

9. In the software, click the **White LUT** button to load the special LUT. This process will take less than 1 minute.

10. Adjust the Analog Gain slider controls is available, otherwise adjust the GAIN 01, 02, and 03 controls until the screen is full of bright white noise. Adjust each control until as pure a white screen as possible can be obtained. Use the IR Remote or IR Remote emulation feature to adjust the GAIN values up or down.

   As the setting value nears the ideal setting, the color being adjusted will start to show as noise. The red, green, and
blue noise will combine to make white noise.

If a color shows as dim but noiseless, it indicates the current setting value is too high, and should be reduced.

**Hint 1:** The edges of the screen may be very different from the center. Concentrate on the noise at the center of the screen.

**Hint 2:** In some cases it may be difficult to find the correct level when only adjusting one color. Try adjusting another color then go back to first color.

**Hint 3:** If it is not possible to locate the correct gain levels that show noise, check the source signal to make sure it is of sufficient voltage level. Proceed again in small increments.

**Hint 4:** Using the IR Remote may be faster than using the Analog Gain slider controls in the software due to the time it takes to update each control.

The following table shows how the screen color will change as the GAIN values are adjusted:

<table>
<thead>
<tr>
<th>SCREEN COLOR</th>
<th>GAIN 01 Value</th>
<th>GAIN 02 Value</th>
<th>GAIN 03 Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>INCORRECT</td>
<td>INCORRECT</td>
<td>INCORRECT</td>
</tr>
<tr>
<td>Gray</td>
<td>TOO HIGH</td>
<td>TOO HIGH</td>
<td>TOO HIGH</td>
</tr>
<tr>
<td>Red Noise</td>
<td>OK</td>
<td>INCORRECT</td>
<td>INCORRECT</td>
</tr>
<tr>
<td>Green Noise</td>
<td>INCORRECT</td>
<td>OK</td>
<td>INCORRECT</td>
</tr>
<tr>
<td>Blue Noise</td>
<td>INCORRECT</td>
<td>INCORRECT</td>
<td>OK</td>
</tr>
<tr>
<td>Yellow Noise</td>
<td>OK</td>
<td>OK</td>
<td>INCORRECT</td>
</tr>
<tr>
<td>Cyan Noise</td>
<td>INCORRECT</td>
<td>OK</td>
<td>OK</td>
</tr>
<tr>
<td>Magenta Noise</td>
<td>OK</td>
<td>INCORRECT</td>
<td>OK</td>
</tr>
<tr>
<td>White Noise</td>
<td>OK</td>
<td>OK</td>
<td>OK</td>
</tr>
</tbody>
</table>

11. In the software, click the **Normal LUT** button to restore the normal LUT. This process will take less than 1 minute.

12. Repeat for all other displays.

13. When complete, evaluate the adjustments using a white video signal from the analog source.
Calibration Method Comparison

Overview

The software provides two different methods of adjusting the displays to achieve the desired calibration target settings. The method used for the calibration is selected in the Preferences on the Advanced tab. The options are:

- **Use LUTs** - Uses LUTs (Look Up Tables) in the display to adjust the white point and grayscale correction. It uses an internally generated test pattern when measuring the display. Custom gamma curves and contrast ratios are possible. This method is slower than the Use RGB Gains method because there are more measurement steps, and the LUT must be transmitted to each display.

- **Use RGB Gains** - Uses the Red, Green and Blue Gain controls on the display to adjust the white point to the incoming video signal. A 100% white video signal must be displayed during the calibration. Custom gamma curves can not be used, and only the fixed Gamma values of 2.2, 2.4, and Native are available. This method is faster than the Use LUTs method, but does not make any grayscale corrections.

The choice of Calibration Method to use will depend on the application and configuration of the video wall, as well as the level of calibration that is desired, versus calibration speed.

The table on the following page compares the features of both methods.
<table>
<thead>
<tr>
<th>Feature</th>
<th>LUT Method</th>
<th>RGB Gain Method</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Full Grayscale Calibration</strong></td>
<td>Yes.</td>
<td>No. Uses factory adjustment.</td>
<td>Use LUT Method if very accurate Grayscale tracking is necessary.</td>
</tr>
<tr>
<td><strong>Uses internal test patterns for calibration</strong></td>
<td>Yes.</td>
<td>No (requires 100% white signal source to be input.)</td>
<td></td>
</tr>
<tr>
<td><strong>Gamma Setting</strong></td>
<td>Custom Gamma Curves and variable gamma values.</td>
<td>2.2, 2.4, and Native Gamma only.</td>
<td>Use LUT Method if a non-standard gamma is necessary.</td>
</tr>
<tr>
<td><strong>Calibration Time</strong></td>
<td>Slower (measures grayscale and transmits LUT to display)</td>
<td>Faster (approximately 1.5 minutes faster per display)</td>
<td>Use RGB Gain Method for the fastest calibration.</td>
</tr>
<tr>
<td><strong>Manual adjustment after calibration</strong></td>
<td>Must use Wall Calibrator Software and project file.</td>
<td>Can use RGB Gain controls on the OSD (On Screen Display).</td>
<td>Use RGB Gain Method if it is desirable to be able to manually adjust a display without having to use the calibration software.</td>
</tr>
<tr>
<td><strong>Contrast Ratio</strong></td>
<td>Specific Contrast Ratios are available (e.g. 300:1)</td>
<td>Not available.</td>
<td>Use LUT Method if a specific Contrast Ratio is necessary.</td>
</tr>
<tr>
<td><strong>Calibrations for each video input</strong></td>
<td>All inputs share the same calibration.</td>
<td>Different inputs can have different calibrations.</td>
<td></td>
</tr>
<tr>
<td><strong>Analog Video Inputs</strong></td>
<td>Calibrates to internal test pattern.</td>
<td>Calibrates to the analog video signal level input, therefore compensating for video level differences.</td>
<td></td>
</tr>
</tbody>
</table>
Glossary

**Achromatic** – Neutral in color (having no hue).

**Additive Primaries** – Red, green, and blue light that when combined in different relative intensities produces different colors. (See also Subtractive Primaries)

**Backlight** – the internal light source for a Liquid Crystal Display, such as fluorescent lamps or array of LEDs (Light Emitting Diodes).

**Blackbody** – A hypothetical object that absorbs all incident radiation, thus any radiation (e.g. light) coming from a blackbody must be emitted from it and not reflected.

**Blackbody Radiator Locus** – The curve formed when the color of light radiated from a blackbody is plotted at different temperatures on a color space such as CIE xyY.

**Black Level** – The luminance or “brightness” of black when displayed on the screen.

**Calibration** – The process of bringing a device such as a display monitor to an absolute standard to ensure consistency over time and with other similarly calibrated devices.

**Candels (cd)** – An international unit of light intensity. Luminance can be described in units of Candels per meter squared (cd/m²) but is often referred to as just Candels or Nits for sake of brevity.

**CCFL** – Cold cathode fluorescent lamp used for the backlight on LCD display panels.

**CIE** – The Commission Internationale d’Eclairage (International Commission on Illumination). An organization that sets many of the standards used in color and color measurement.

**CIE uv chromaticity coordinates** – Coordinates in the CIE uv color space which are derived directly from CIE xyY color space. CIE uv is more perceptually uniform than CIE xy.

**CIE xy chromaticity coordinates** – Coordinates in the CIE xyY color space representing color independent of luminance.

**CIE xyY** – A standard color space in which the Y component represents luminance. The x and y components represent color.

**Color Gamut** – (See Gamut)

**Colorimeter** – An optical measurement device used to measure color that responds to light by separating it into red, green, and blue components.

**Color Temperature** – The color of light given off by an object, known as a blackbody, as it is heated to a given temperature in degrees Kelvin. Low color temperatures such as 5000K are reddish, whilst higher color temperatures such as 9300K are bluish. A color temperature of 6500K is considered to be “neutral” white.

**COM Port** – The original name of the serial port interface on IBM PC-compatible computers.
**Contrast Ratio** – The ratio of the white luminance (Intensity) and black luminance (Black Level) of the display.

**Correlated Color Temperature** – The closest matching color, expressed in Kelvin, of a white point that does not lie exactly on the blackbody locus.

**D Illuminants** – CIE Daylight Standard Illuminants based on approximating daylight. The subscript denotes the correlated color temperature of the illuminant. For example, D50 has a correlated color temperature of 5000K.

**Delta-E (Δ-E)** – A measurement of how different two colors are to each other. In *NEC Display Wall Calibrator*, Delta-E values are derived by calculating the distance between two colors in Lab color space using the CIE 94 formula. A Delta-E value of 1 indicates a just perceptual difference between two colors.

**Delta-uv (Δ-uv)** – A measure of how different two colors are, irrespective of luminance. In *NEC Display Wall Calibrator* Delta-uv values are used to indicate how far a white point is from the blackbody locus. CIE uv color space is used instead of CIE xy because it is more perceptually uniform or linear.

**Device Gamut** – The range of colors that a device can produce.

**DICOM** – Digital Imaging and Communications in Medicine.

**Foot Lamberts (fL)** – A unit of luminance. One foot Lambert is equal to 1 Candela per meter squared divided by $10.76/\pi$ (approximately 3.43).

**Gamma** – The relationship between the input video signal to a display monitor and the screen output luminance. Typically the screen luminance follows a mathematical power function of the input video signal, the exponent of which is called the gamma.

**Gamut** – The range of colors that can be reproduced on a particular device such as a monitor or printer, or that can be distinguished by a sensing device such as a scanner or the human eye.

**Hue** – The basic attribute of color such as red, green, yellow, blue or purple.

**Intensity** – Intensity specifies the luminance or brightness of white when displayed on the screen.

**IP** – Internet Protocol.

**Kelvin** – An absolute temperature scale denoted by K. Zero Kelvin (0K) is equivalent to −273° Celsius.

**Lab** – (See CIE Lab)

**LAN** – Local Area Network

**LCD** – Liquid Crystal Display.

**Luminance** – A measure of the brightness or intensity of light, usually expressed in units of Candelas per meter squared (cd/m²) or foot Lamberts.

**Look Up Table (LUT)** – A table used to translate input values to output values. *NEC Display Wall Calibrator* displays use 10 bit internal LUTs to apply Gamma corrections and Tone Response Curves.
**Native state** – Without any kind of correction or calibration applied.

**Nit** – A unit of luminance equal to Candelas per meter squared (cd/m²).

**OSD** – On Screen Display.

**RS232** - Recommended Standard 232 is a standard for serial binary data signals.

**Saturation** – An expression of the amount a color deviates from being achromatic (neutral in color, such as gray). For example, red is a saturated color, while pink is less saturated, and white has no saturation.

**Subnet** – A subnetwork, or subnet, describes networked computers and devices that have a common, designated IP address routing prefix.


**Tone Response Curve** – A graph representing the relationship between the input and output of a system or device. In *NEC Display Wall Calibrator*, Tone Response Curves represent the relationship between the intensity of a color within an application and the light intensity displayed on the monitor.

**USB** – Universal Serial Bus. A communication bus used to connect up to 127 devices such as keyboards, mice, scanners, color sensors, etc.

**White point** – Specifies the color of pure “white” on a display, usually as a Color Temperature expressed in Kelvin or as CIE xy chromaticity coordinates.